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Safety Information RIO Modules

Safety Information

Important Information

Read these instructions carefully, and look at the equipment to become familiar with the
device before trying to install, operate, service, or maintain it. The following special
messages may appear throughout this documentation or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not
followed.

hazards. Obey all safety messages that follow this symbol to avoid possible injury or
death.

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

2 This is the safety alert symbol. It is used to alert you to potential personal injury

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

EI00000001584.13 7



RIO Modules Safety Information

Please Note

Electrical equipment should be installed, operated, serviced, and maintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction and
operation of electrical equipment and its installation, and has received safety training to
recognize and avoid the hazards involved.

Before You Begin

Do not use this product on machinery lacking effective point-of-operation guarding. Lack of
effective point-of-operation guarding on a machine can result in serious injury to the
operator of that machine.

AWARNING

UNGUARDED EQUIPMENT

* Do not use this software and related automation equipment on equipment which does
not have point-of-operation protection.

* Do not reach into machinery during operation.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

This automation equipment and related software is used to control a variety of industrial
processes. The type or model of automation equipment suitable for each application will
vary depending on factors such as the control function required, degree of protection
required, production methods, unusual conditions, government regulations, etc. In some
applications, more than one processor may be required, as when backup redundancy is
needed.

Only you, the user, machine builder or system integrator can be aware of all the conditions
and factors present during setup, operation, and maintenance of the machine and,
therefore, can determine the automation equipment and the related safeties and interlocks
which can be properly used. When selecting automation and control equipment and related
software for a particular application, you should refer to the applicable local and national
standards and regulations. The National Safety Council's Accident Prevention Manual
(nationally recognized in the United States of America) also provides much useful
information.

In some applications, such as packaging machinery, additional operator protection such as
point-of-operation guarding must be provided. This is necessary if the operator's hands and
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other parts of the body are free to enter the pinch points or other hazardous areas and
serious injury can occur. Software products alone cannot protect an operator from injury. For
this reason the software cannot be substituted for or take the place of point-of-operation
protection.

Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-
operation protection have been installed and are operational before placing the equipment
into service. All interlocks and safeties related to point-of-operation protection must be
coordinated with the related automation equipment and software programming.

NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-
operation protection is outside the scope of the Function Block Library, System User
Guide, or other implementation referenced in this documentation.

Start-up and Test

Before using electrical control and automation equipment for regular operation after
installation, the system should be given a start-up test by qualified personnel to verify
correct operation of the equipment. It is important that arrangements for such a check are
made and that enough time is allowed to perform complete and satisfactory testing.

AWARNING

EQUIPMENT OPERATION HAZARD
« Verify that all installation and set up procedures have been completed.

+ Before operational tests are performed, remove all blocks or other temporary holding
means used for shipment from all component devices.

* Remove tools, meters, and debris from equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Follow all start-up tests recommended in the equipment documentation. Store all equipment
documentation for future references.

Software testing must be done in both simulated and real environments.

Verify that the completed system is free from all short circuits and temporary grounds that
are not installed according to local regulations (according to the National Electrical Code in
the U.S.A, for instance). If high-potential voltage testing is necessary, follow
recommendations in equipment documentation to prevent accidental equipment damage.

Before energizing equipment:
* Remove tools, meters, and debris from equipment.
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* Close the equipment enclosure door.
* Remove all temporary grounds from incoming power lines.
» Perform all start-up tests recommended by the manufacturer.

Operation and Adjustments

The following precautions are from the NEMA Standards Publication ICS 7.1-1995:

(In case of divergence or contradiction between any translation and the English original, the
original text in the English language will prevail.)

* Regardless of the care exercised in the design and manufacture of equipment or in the
selection and ratings of components, there are hazards that can be encountered if such
equipment is improperly operated.

+ Itis sometimes possible to misadjust the equipment and thus produce unsatisfactory or
unsafe operation. Always use the manufacturer’s instructions as a guide for functional
adjustments. Personnel who have access to these adjustments should be familiar with
the equipment manufacturer’s instructions and the machinery used with the electrical
equipment.

» Only those operational adjustments required by the operator should be accessible to
the operator. Access to other controls should be restricted to prevent unauthorized
changes in operating characteristics.
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About the Book

Document Scope

This document describes the adapter modules that can be used in X80 RIO drops.

This guide describes these adapter modules:

BMECRA31210
BMXCRA31210
BMXCRA31200

NOTE: This book discusses BM*CRA312+1 adapter modules in M580 systems. To use
Quantum 140CRA312+0 adapter modules in an M580 system, refer to chapter
Characteristics of Ethernet Remote I/0O Modules (see Quantum EIO, Remote I/O
Modules, Installation and Configuration Guide).

These CPUs support Quantum RIO drops that include a 140CRA312+0 adapter module:

BMEP584040 (version 2.10 or later)
BMEP585040
BMEP586040
BMEH584040
BMEH586040

NOTE: The specific configuration settings contained in this guide are for instructional
purposes only. The settings required for your specific application can be different from
the examples presented in this guide. To configure RIO drops in an M580 Hot Standby
system, refer to the chapter M580 (e)X80 RIO Drops (see Modicon M580 Hot Standby,
System Planning Guide for, Frequently Used Architectures).

NOTE: The architectures described in this document have been tested and validated in
various scenarios. If you intend to use architectures different than the ones described in
this document, test and validate them thoroughly before implementing.

Validity Note

This document is valid for X80 RIO systems when used with EcoStruxure™ Control Expert
15.1 or later.

The characteristics of the products described in this document are intended to match the
characteristics that are available on www.se.com. As part of our corporate strategy for
constant improvement, we may revise the content over time to enhance clarity and
accuracy. If you see a difference between the characteristics in this document and the
characteristics on www.se.com, consider www.se.com to contain the latest information.
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Related Documents

Title of documentation

Reference number

Electrical installation guide

EIGED306001EN (English).

Modicon M580, M340, and X80 I/O Platforms,
Standards and Certifications

EI00000002726
EIO0000002727
EI00000002728
EIO0000002730
EI00000002729
EI00000002731

English),
French),
German),
Italian),
Spanish),
Chinese).

~ e~~~ o~ o~

Modicon M580 Standalone, System Planning Guide for
Frequently Used Architectures

HRB62666 (English), HRB65318 (French),
HRB65319 (German), HRB65320 (ltalian), HRB65321
(Spanish), HRB65322 (Chinese)

Modicon M580, System Planning Guide for Complex
Topologies

NHA58892 (English), NHA58893 (French),
NHA58894 (German), NHA58895 (Italian), NHA58896
(Spanish), NHA58897 (Chjnese)

Modicon M580 Hot Standby, System Planning Guide
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NHA58885 (Chinese).
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EIO0000001578
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EI00000001580
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EI00000001581
EI00000001583

ENG)
FRE)
GER)
ITA)

SPA)
CHS)

P e L D

Modicon X80 Racks and Power Supplies, Hardware,
Reference Manual

EI00000002626 (ENG)
EI00000002627 (FRE)
EI00000002628 (GER)
EI00000002630 (ITA)

EI00000002629 (SPA)
EI00000002631 (CHS)

Modicon X80, BMXERT1604T Time Stamp Module,
User Guide

EI00000001121 (English), EIO0000001122 (French),
EI00000001123 (German), EIO0000001125 (ltalian),
EI00000001124 (Spanish), EIO0000001126
(Chinese)

Modicon X80, BMXNOMO0200 Serial Link Module, User
Manual

EI00000002696 (English), EIO0000002697 (French),
EI00000002698 (German), EIO0000002699 (ltalian),
EI00000002700 (Spanish), EI00000002701
(Chinese)

Quantum EIO, Remote I/0 Modules, Installation and
Configuration Guide

S1A48978 (English), S1A48981 (French), S1A48982
(German), S1A48983 (ltalian), S1A48984 (Spanish),
S1A48985 (Chinese)

Quantum using EcoStruxure™ Control Expert,
Hardware Reference Manual

35010529 (English), 35010530 (French), 35010531
(German), 35013975 (Italian), 35010532 (Spanish),
35012184 (Chinese)
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31007131 (English), 31007132 (French), 31007133
(German), 31007494 (Italian), 31007134 (Spanish),
31007493 (Chinese)

System Time Stamping, User Guide
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EIO0000001707
EIO0000001708 (German),
EIO0000001710 (ltalian),

EIO0000001709 (Spanish),
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French),
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To find documents online, visit the Schneider Electric download center

(www.se.com/ww/en/download/).
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Characteristics of Ethernet RIO Modules

Introduction

This chapter describes the adapter modules that can be used in the remote drops of an X80
system. Specifically, these modules are:

+ BMECRA31210
+ BMXCRA31210
+ BMXCRA31200

This chapter includes physical characteristics, port descriptions, and agency specifications
for these modules.

NOTE: This book describes the BM+ CRA 312 «1 adapter modules. To use Quantum 140
CRA adapter modules in M580 systems, refer to the Quantum RIO Modules guide (see
Quantum EIO, Remote I/0O Modules, Installation and Configuration Guide).

Adapter Module Descriptions

Introduction

An RIO drop consists of one or two racks of Modicon X80 I/O modules and/or third-party
PMESWTO0100 modules. An RIO drop is connected to the daisy-chain loop on which the
Ethernet RIO network resides. Each remote drop contains one BM«CRA312+0 adapter
module. Each rack in a remote drop contains its own power supply module.

Remote adapter modules are available as Ethernet BME and X Bus BMX communicators.
To use X80 I/O modules that require Ethernet, choose a BME-style adapter module. If your
eX80 /0O uses X Bus exclusively for backplane communications, you can use a BMX-style
adapter module.

These are the available types of adapter modules:

14 EI00000001584.13
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Adapter

Description

eX80 standard EIO
adapter

The BMXCRA31200 is a basic adapter module that supports X Bus communications (not
Ethernet) across the remote backplane.

It does not support:

.

special-purpose or Ethernet /O modules
native time stamping
service ports

1/0 to be solved more than once per logic scan in the remote drop. (It only handles
MAST, page 67 tasks. Your application cannot assign FAST and AUX tasks in it.)

eX80 performance
EIO adapter

The BMXCRA31210 adapter module supports X Bus communications (not Ethernet)
across the remote backplane.

It supports:

.

an extension rack
special-purpose modules
native time stamping
service ports

MAST, page 67, FAST, page 67, and AUXO0, page 67/AUX1, page 67 task
customization of the Ethernet I/O scanner service

eX80 performance
EIO adapter

The BMECRA31210 adapter supports Ethernet and X Bus communications across the
remote backplane. Install this adapter in an Ethernet backplane.

It supports:

the capabilities of a BMXCRA31210 adapter

Ethernet /0O modules on rack slots connected to the Ethernet backplane in the
remote drop, such as the BMEAHI0812 and BMEAHO0412 HART-compatible
analog modules, and PME SWT 0100 weighing module

NOTE: You can also use BMECRA312+0 eX80 EIO adapter modules in a Quantum EIO
system with a high-end controller (140CPUGe+++ (see Quantum using EcoStruxure™
EcoStruxure Control Expert, Hardware, Reference Manual)) configured on the local

rack.

RIO Drop Maximum Configuration

The maximum number of channels in an RIO drop depends on the eX80 EIO adapter

module:

EI00000001584.13
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RIO Modules
EIO adapter Maximum Number of Channels
Discrete Analog Expert Sensor Bus
BMXCRA31200 128 16 — —
BMXCRA31210 1024 256 36 2
BMECRA31210 1024 256 36 2

NOTE: The number of available channels can differ from these maximum values
because the values depend on the controller reference and other modules in the same
drop. Refer to the description of Modicon X80 1/0 Modules, page 24.

To configure Quantum RIO drops, refer to the Quantum EIO installation and
configuration guide.

Functionality

The adapters exchange data through the Ethernet I/0O scanner service in the controller on
the main local rack of your controller system:

« The input data from the RIO drop is collected and published to the I/O scanner.
» The output modules are updated with the data received from the I/O scanner.

» The protocol used for exchange is EtherNet/IP.
+ Data exchanges are deterministic; RIO logic is scanned regularly in a scheduled and
predictable manner.

NOTE: Refer to your system hardware reference manual to select a controller that
supports the Ethernet I/0O scanner service.

16 EI00000001584.13
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External Features

These adapter modules have the same dimensions and installation constraints as other
modules in the Modicon X80 product line:

BME CRA 312 10
BMX CRA 312 10 BMX CRA 312 00

1 LED display

2 rotary switches

3 SERVICE port (ETH 1)

4 DEVICE NETWORK port (ETH 2)

5 DEVICE NETWORK port (ETH 3)
NOTE: Refer to the description of LEDs, page 18.
Ethernet ports are labeled on the front of the modules.

EI00000001584.13
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NOTE: Insert dust covers into unused Ethernet ports on the adapter modules:

&l

Ruggedized Versions

The BMECRA31210C and BMXCRA31210C (coated) equipment are ruggedized versions of
the respectively BMECRA31210 and BMXCRA31210 (standard) equipment. They can be
used at standard temperatures and in harsh chemical environments.

For more information, refer to chapter Installation in More Severe Environments. (Refer to
Modicon M580, M340, and X80 I/O Platforms, Standards and Certifications.)

Altitude Operating Conditions

These characteristics apply to the eX80 EIO adapter modules BM*CRA312+0(C) for use at
altitude up to 2000 m (6560 ft). When these modules operate above 2000 m (6560 ft), apply
additional derating.

For detailed information, refer to chapter Operating and Storage Conditions. (Refer to
Modicon M580, M340, and X80 I/O Platforms, Standards and Certifications.)

LED Indicators on Adapter Modules

Display

The LEDs are on the front of the adapter module:

® RUN 110
o MS @NS

18 EI00000001584.13
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RIO Modules

Indications

NOTICE

UNINTENDED EQUIPMENT BEHAVIOR

Confirm that each module has a unique IP address. Duplicate IP addresses can cause
unpredictable module/network behavior.

Failure to follow these instructions can result in equipment damage.

LED conditions:
Module State(") Description Run 10 MS (Module Status) | NS (Network
Status)
Green Red Green Red Green Red
power-up Order of LEDs blinking 1 2 3 4 5 6
sequence
not configured IP address not valid - - flashing off off off
valid IP address, but invalid | off off flashing off flashing off
configuration
configured no external error detected flashing | off - - flashing off
external error detected flashing on - - flashing off
I/O data STOP flashing (NOTE on off on off
communication 1)
established
RUN on (NOTE on off on off
2)
detected error recoverable error - - off flashing - -
states
nonrecoverable error flashing | on off on - -
One or more owner - - - - - flashing
connections has timed out
duplicate IP address - - - - off on

EI00000001584.13
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Module State(1) Description Run 10 MS (Module Status) | NS (Network
Status)
Green Red Green Red Green Red
during OS firmware update flashing off off on off on

(1) For more information about the module states, refer to your system hardware reference manual.

NOTE 1 (STOP state):

« on: Aninput or output is a detected error that originates in a module, or a channel configuration or a channel
configuration error has been detected.

« off: Operations are normal.
NOTE 2 (RUN state):

« on: External error is detected.

«  off: External error is not detected.

Ethernet Port Indications

—rLINK

[CTacr
ACT—

LINK— ﬂ]

These LEDs report the status of the Ethernet port:

Name Color Status Description

LINK green on 100 Mbps link detected
yellow on 10 Mbps link detected
- off no detected link

ACT green blinking active Ethernet link (transmit or receive)
- off inactive Ethernet link

20 EI00000001584.13
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Adapter Ethernet Ports

Ethernet Port Descriptions

Two of the Ethernet ports allow implicit I/O exchanges with the I/O scanner in the CPU. (An
implicit I/0 exchange has a maximum frame size of 1400 bytes.) The ports can be
implemented alone or in redundant mode.

You can use a maximum of 31 adapters in a single Ethernet RIO network depending on the
CPU used. For network topology planning, refer to the planning guide for your system.

These adapter modules have two or three 10/100 Base-T Ethernet ports:

Port Description
SERVICE The SERVICE port allows the diagnosis of Ethernet device network ports and provides access to
external tools and devices (Control Expert, ConneXium Network Manager, HMI, and so forth).
The port supports these modes:
» access port (default): This mode supports Ethernet communications.
»  port mirroring: In this mode, data traffic from one of the other 2 ports is copied to this port.
This allows a connected management tool to monitor and analyze the port traffic.
+ disabled
NOTE:
+ The BMXCRA31200 does not have a SERVICE port.
* You can configure the SERVICE port either ONLINE or OFFLINE.
* In port mirroring mode, the SERVICE port acts like a read-only port. That is, you
cannot access devices (ping, connection to Control Expert, and so forth) through the
SERVICE port.
Refer to Service Port Configuration, page 54.
DEVICE The DEVICE NETWORK copper ports are used to put the drop on the simple daisy chain loop.
NETWORK

They provide:
» connections for RIO communications
» cable redundancy

ACAUTION

ETHERNET CONNECTION NON-OPERATIONAL
Do not connect a device with a speed in excess of 100 Mbit/s to any adapter port.

Failure to follow these instructions can result in injury or equipment damage.

Connecting a device with a speed in excess of 100 Mbit/s , the Ethernet link may not be
established between the device and the module through its port.

EI00000001584.13
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BMECRA31210 Keying Pin

The BMECRA31210 adapter is designed to be installed on an Ethernet backplane in the
main remote rack. The adapter supports the Modicon X80 I/O and partner modules with
both Ethernet and X Bus connections. The two bus connectors are shown in items 1 and 2

below.

The adapter also has a keying pin (item 3 below) to keep it from being installed on a
BMEXBP PV 01 backplane.

Rear view of the adapte

BME CRA 31210

r module:

X Bus backplane connector

Ethernet backplane connector

Keying pin

22
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RIO Network Cable Installation

Introduction

Use a daisy chain loop network configuration that implements the RSTP service to establish
redundant communications with at least one of the two physical paths between:

» the I/O scanner

« the adapter modules at each remote drop, dual ring switches (DRSs), or any product
that has the capacity to be RIO scanned

For network topology planning, refer to your system planning guide.

NOTE: Fiber optic ports are not available on the adapter modules. For fiber optic
support use either a BMXNRP020- optic fiber conversion module or a pair of DRSs.

RIO Simple Daisy Chain Loop

The CPU supports communications with RIO drops in a daisy chain loop:

o

1 main local rack with a BME+58+240 CPU with the Ethernet I/O scanner service
2 X80 RIO drops with a BM*CRA312+0 adapter module
3 the daisy chain loop
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Modicon X80 I/0O Modules

Introduction

The following 1/0 modules can be mounted in local racks or RIO drops in an M580 system.

Unless otherwise noted in the following tables, X80 I/O modules are supported on the
following racks in RIO drops:

* an X Bus rack with a BMXCRA312+0 X80 EIO adapter module

» an Ethernet rack with a BMECRA312+0 eX80 EIO adapter module

Some of these modules also contain embedded web pages that can be used for
configuration and diagnostics. Web page descriptions are provided in the appropriate
product documentation and in Control Expert help.

NOTE: Conformally coated (hardened H) versions of many of these modules are also
available. Refer to the specifications for hardened equipment in the Modicon M580,
M340, and X80 I/O Platforms, Standards and Cetrtifications guide.

Modicon X80 Analog Modules

Modules that require Ethernet across the backplane can be installed only in main local or
remote local racks. They cannot be installed in extended racks.

NOTE: Debug screens are not available for analog modules in RIO drops and the
parameters can’t be changed (Alignment, Filter, Offset...). If you need to modify the
parameters, use the analog modules in local or local extended racks.

These analog I/0 modules are supported in Modicon X80 local racks containing a CPU and

RIO drops:
Type of Module Installation on...
Module
Main Local Extended Main Extended
Rack Local Rack Remote Remote Rack
Rack
input BMXAM|[eeee +3) +(@3) + +
BMXARTseee(1) +(3) +(3) + +
BMEAHI0812(2) +(3) - +(4) -
output BMXAMOQs¢e+e +(3) +@3) + +
BMEAHO0412(2) +@3) - +(3) -
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Type of Module Installation on...
Module
Main Local Extended Main Extended
Rack Local Rack Remote Remote Rack
Rack
input/output | BMXAMMO0600 +©) +@) + +

+ Allowed

- Not allowed

(1) The FAST task is not supported.
(2) These modules require an Ethernet backplane.

(3) Not supported in an M580 Hot Standby system.

(4) When installed in an RIO drop, use a BM*CRA31210 (e)X80 performance EIO adapter module. These
modules are not compatible with BM*CRA31200 (e)X80 standard EIO adapter modules.

NOTE: A maximum of 2 analog modules are allowed on an RIO drop that contains a
BMXCRA31200.2 X80 EIO adapter module. These analog modules can have a
maximum of 8 channels (16 for analog I/0 modules).

When the following modules are used in a local rack (containing a CPU) and RIO drops,

they require these versions:

Module Product Version Software Version
BMXAMI0410 PV5 SV1.1
BMXAMMO0600 PV5 or later SV1.2
BMXAMO0210 PV7 or later SV1.1
BMXART0414 PV5, PV6 SV2.0

PV7 Sv2.1
BMXART0814 PV3, PV4 SV2.0

PV5 or later SV2.1

NOTE: Schneider Electric recommends that you upgrade the modules with the latest
available software version. (It is not necessary to update a BMXART0414 module, V2.1
or later, because it works correctly with a BM*CRA312+0 X80 EIO adapter module).

EI00000001584.13
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Modicon X80 Discrete Modules

NOTE: In the CPU configuration screen in Control Expert, you can configure a digital I/O
module channel as a RUN/STOP input by selecting this check box. This can be
performed on a local I/0 channel in topological I/O data type only. (This configuration is

not available in Hot Standby systems).

These discrete I/O modules are supported in Modicon X80 local racks containing a CPU and

RIO drops:
Type of Module Installation on...
Module
Main Local Extended Main Extended
Rack Local Rack Remote Remote Rack
Rack
input BMXDA[esee +2) +(2) + +
BMXDDeeee(1) +Q2) +@) + +
output BMXDAOQs¢ee+ +(2) +(2) + +
BMXDDQs¢eee +(2) +@2) + +
BMXDRAs®¢*s(1) +(2) +(2) + +
BMXDRCeee +(2) +@2) + +
input/output | BMXDDMseee +@2) +(@2) + +

information in I/O module hardware guides for your platform.
(2) Not supported in an M580 Hot Standby system.

+ Allowed

- Not allowed

(1) Before installation of 1/O modules that use a 125 VVdc power supply, refer to the temperature derating

NOTE: Schneider Electric recommends that you upgrade the modules with the latest
available software version. (It is not necessary to update a BMXART0414 module, V2.1
or later, because it works correctly with a BM«CRA312+0 X80 EIO adapter module.)

Communication Modules

NOTE: The maximum number of communication modules you can install on the local
rack depends upon the CPU you choose (see Modicon M580 Standalone, System
Planning Guide for, Frequently Used Architectures).

These communication modules are supported in M580 local racks (containing a CPU with
Ethernet I/O communication server service) and RIO drops that contain a BM*CRA312+0

X80 EIO adapter module:
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RIO Modules

Module Comment Installation on...
K4 E 4 k4 K4
3] [5) 2] [5)
] © ] ©
14 14 x 14
ERERE
S |S |§ |&
£ 3 (14 14
s |2 |5 |3
g |= |B
x [7]
w %
i
BMXNOMO0200(") | Only MAST task is supported. +@) | +@) | +@) | +
Additional restrictions are described in chapter BUXNOMO0200
Limitation and Implementation Rules (see Modicon X80,
BMXNOMO0200 Serial Link Module, User Manual).
Refer to the instruction to configure the BMXNOMO0200 module
in an X80 RIO drop, page 31
BMXNORO0200 Only MAST task is supported. +@) | +@) | - -
BMXNGD0100 Dedicated to global data. +@) | - - -
For configuration details, refer to the BMXNOEO100 user guide
(3100713¢) (see Modicon M340 for Ethernet, Communications
Modules and Processors, User Manual). The BMXNGDO0100
module has the same global data functionality as the
BMXNOEO0100, but it does not support these services: I/O
scanning, address server, time synchronization, bandwidth
monitoring, or web pages.
BMXEIA0100(1) Only MAST task is supported. +@) | +Q) | +@4) |+
A maximum of 16 AS-i modules in an M580 configuration is
allowed.
A maximum of two AS-i modules on an RIO drop containing a
BM+CRA3-+ X80 EIO adapter is allowed.
The following maximum number of AS-i modules on a local rack
containing one of the following CPUs is allowed.
+  BMEP581020: two
+  BMEP582020: four
+  BMEP582040: four
+  BMEP583020: six
+  BMEP583040: six
+  BMEP584020: eight
+  BMEP584040: eight
+  BMEP585040: eight
+  BMEP586040: eight
A maximum of 16 AS-i modules is allowed in RIO drops in an
M580 system that uses BME+585040 or BME+586040 CPUs.
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Module Comment Installation on...
K4 K4 < K4
o Q o Q
© © © ©
14 14 14 14
ERERE
S |S |§ |&
£ 3 14 14
©
= |2 | |3
g |= |8
x [7]
u X
[
BMECXM0100 Connects an M580 CPU on an Ethernet network to CANopen +@) | - + -
fieldbus devices.
Requires an Ethernet backplane.
BMXNRP0200, Fiber cable conversion + + + +
BMXNRP0201

(1) If a BMXNOMO0200 module and a BMXEIA0100 module are included on the same RIO drop, only one
BMXNOMO0200 module and two BMXEIA0100 modules maximum are allowed.

(2) Compatible with M580 CPUs V2.00 or later only.
(3) Not supported in an M580 Hot Standby system.

(4) When installed in an RIO drop, use a BM*CRA31210 (e)X80 performance EIO adapter module. These
modules are not compatible with BM*CRA31200 (e)X80 standard EIO adapter modules.

+ Allowed

- Not allowed

Counting Modules

NOTE: When installed in an RIO drop, use a BM*CRA31210 (e)X80 performance EIO
adapter module. These modules are not compatible with BM*CRA31200 (e)X80
standard EIO adapter modules.

NOTE: I/O event tasks are supported only through topological data type, not through
device DDT.

These counting modules are supported in M580 local racks (containing a CPU with Ethernet
I/O communication server service) and RIO drops that contain a BM*CRA31210 (e)X80 EIO
performance adapter module:
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Module Comment Installation on...
E 4 £ 4 K4 K4
Q Q Q 3]
] 3] © ]
14 14 14 x
ERERE
S |18 |g |E
£ 3 14 (4
©
= |8 |£ |3
g |= |B
x [
w x
i
BMXEHC0200 +M | () |+ +
BMXEHC0800 When configuring a BMXEHC0800 module, the dual phase + )+ |+ +
counting mode function is not available in X80 EIO drops or
when using device DDT in local racks.
When configuring a BMXEHC0800.2 module the dual phase
counting mode function is available in X80 EIO drops and
when using device DDT in local racks. In this case the event
feature is not available.
BMXEAEOQ0300 In RIO drops: +(1) | +() | + +
« Events are not supported.
If events are needed, move the module to the local
rack.
* A maximum of 36 channels can be configured.
(1) Not supported in an M580 Hot Standby system.
+ Allowed
- Not allowed

When the following modules are used in a local rack (containing a CPU) and RIO drops,

they require these versions:

Module Product Version Software Version
BMXEHC0200 PV3 SV1.1
BMXEHC0800 PV3 SV1.1

NOTE: Schneider Electric recommends that you upgrade the modules with the latest
available software version.

EI00000001584.13
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Intelligent and Special Purpose Modules

These intelligent/special purpose modules are supported in M580 local racks (containing a
CPU with Ethernet I/O communication server service) and RIO drops that contain a
BM+-CRA312+0 X80 EIO adapter module:

Module Comment Installation on...
k4 E 4 E 4 E 4
(2] Q o (%]
] 3] ] ]
14 14 14 o
® m 2 3
o 3] o <)
S |8 | |E
£ |3 |2 |2
©
= |8 |5 |3
g |= |8
x [
w x
L
BMXERT1604T Limitations for the time stamping module are described in +@ | +@ | +OG) |+
chapter Compatibility and Limitations (see Modicon X80,
BMXERT1604T/H Time Stamp Module, User Manual).
PMXNOWO0300 wireless multi-function access point/bridge +@ | +@ |+ +
PMXCDA0400 diagnostic (machines, processes, and infrastructures) +2) | +@ |+ +
PMESWTO0100( This is an Ethernet weighing transmitter (1 channel) and +@ | - + -
requires an Ethernet backplane.
PMEUCMO0302 universal communication +@ | - + -
This requires an Ethernet backplane.
PMEPXMO0100 Profibus DP/DPV1 master module that requires an Ethernet | +#) | +@4) | +(5) | +(5)
backplane
BMENOR2200H Modicon M580 BMENOR2200H Advanced RTU Module
BMENUAO0100 Ethernet communication module with embedded OPC UA + - - -
server

(1) Scanned as a device by the DIO scanner in the CPU.

(2) Not supported in an M580 Hot Standby system.

(3) When installed in an RIO drop, use a BM*CRA31210 (e)X80 performance EIO adapter module. These
modules are not compatible with BM*CRA31200 (e)X80 standard EIO adapter modules.

(4) Not supported on a local rack in an M580 standalone system.

(5) Not supported on an EIO remote drop in an M580 Hot Standby system.

+ Allowed

- Not allowed
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Configuring the BMXNOMO0200.4 Module in an X80
Drop

Introduction

In X80 EIO drops, Modbus slave messages received by the BMXNOMO0200 module are
transferred to the X80 EIO adapter module (BMXCRA31210 or BMECRA31210). The
adapter module forwards the message to the controller.

To configure the BMXNOMO0200 as a Modbus RS-485 RTU slave in an X80 drop, use these
firmware versions and Control Expert Hardware Catalog devices:

Module Firmyvare Control Expert Hardware Catalog device
version

BMXNOMO0200 SVz2V15 BMXNOMO0200.4

BMXCRA31210 SV 2V2.14 BMXCRA31210 (SV >=2.10)

or or

BMECRA31210 BMECRA31210 (SV >=2.10)

The BMXNOMO0200 module is configured differently in an M580 X80 drop than Quantum
RIO drop, and is compatible with M580 BME+58++40 controllers.

Installing a BMXNOMO0200.4 Module

To install a BMXNOMO0200.4 module in an X80 drop, follow these steps:

Step Action
1 Install the controller module on the local backplane.
2 Install the adpater module BMXCRA31210 (SV >=2.10) or BMECRA31210 (SV >=2.10) on an X80
drop.
3 Install the BMXNOMO0200.4 module in the X80 drop.

Supported Protocols

For the BMXNOMO0200.4 module:
* Channel 0 supports RS-232 or RS-485.
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» Channel 1 supports only RS-485.

Declaring the BMXNOMO0200 module as a BMXNOMO0200.4 module in Control Expert allows
you to configure the module for:

* Modbus RTU slave on RS-485

NOTE:

o Only Modbus RTU is supported as slave protocol.

o Only RS-485 is supported when Modbus slave is selected.
* Modbus Serial RTU and ASCII Master on RS-232 and RS-485
» Character mode

Hot Standby

The controller Main IP address swaps in the case of a PAC switchover. The Modbus

requests are still forwarded to the primary controller.

NOTE: The Modbus client application manages the repetition of requests in case of a
message loss that could occur during a PAC switchover.

Maximum Configuration

The maximum configuration of the BMXNOMO0200.4 module includes the following
elements:

Element Maximum configuration

Master channel Twelve (12) per configured drop with a maximum of 36 expert channels per drop,
taking into account the total maximum channels available for the controller (see
below)

NOTE: Each configured channel of the BMXNOMO0200.4 module counts as an
expert channel.

Drop Six (6) BMXNOMO0200.4 per drop.

NOTE: With M580 controller OS version <2.40, the maximum number of
BMXNOMO0200.4 per drop is limited to four (4).

M580 system Thirty-one (31) BMXNOMO0200.4

Modbus frame length 256 bytes

32

EI00000001584.13



Characteristics of Ethernet RIO Modules RIO Modules

Supported Modbus Function Codes

This table lists the supported Modbus function codes (FC):

Binding to -> Variable type Code Function

Modbus FC:

01 %M 0X Read coil status (output bit)
02 %M 1X Read input status (input bit)
03 %MW 4X Read holding registers

05 %M 0X Force single coil

04 %MW 3X Read input register

06 %MW 4X Write single register

15 %M 0X Write multiple coils

16 %MW 4X Write multiple registers

23 %MW 4X Read/write multiple registers

Accessing the Channel Configuration Screens

To access the channel configuration screens of the BMXNOMO0200.4 module, follow these

steps:
Step Action
1 In the Control Expert Project Browser, open the BMXNOMO0200.4 module.
2 Select the channel to configure. By default:

* Channel 0 is configured with the Character mode link function.
Channel 1 is configured with the Modbus link function.
NOTE: Some parameters are not accessible and are grayed out.

NOTE: Refer to the Modicon X80, BMXNOMO0200 Serial Link Module, User Manual for
details on these communication protocols.

Configuring Slave Modbus Link Communication

This table shows the default parameter values for the Modbus slave configuration screen:
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Configuration parameter

Default value

Type Slave

Slave number 1

Physical line RS-485 only
Signals RX/TX only

Transmission speed

19200 bits/s

Delay between frames 2ms
Data 8 bits only
Stop 1 bit
Parity Even

Standards and Certifications

Download

Click the link that corresponds to your preferred language to download standards and
certifications (PDF format) that apply to the modules in this product line:

Title

Languages

Modicon M580, M340, and X80 I/O Platforms,
Standards and Certifications

* English: EIO0000002726
*  French: EIO0000002727

* German: EIO0000002728
+ ltalian: EIO0000002730

*  Spanish: EIO0000002729
» Chinese: EIO0000002731
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Installation

Overview

This chapter describes the hardware installation of an Modicon X80 remote I/O drop.

Installing Modicon X80 Modules

At a Glance

This section describes the installation of an Modicon X80 I/O adapter module.

Maximum Configuration in RIO Drops

Maximum Configuration

The maximum number of I/O modules in an Modicon X80 RIO drop (with both a main
remote rack and an extension remote rack) using a BM«CRA312+0 adapter depends on the
CPU used in the main local rack.

Refer to your system hardware reference manual to select a CPU that supports the number
and types of /O modules you need.

This table shows the maximum number of modules in an RIO drop with a remote extension

rack:

Module Type Modules in a Drop Comment

RIO adapter 1 —

power supply 2 —

bus extension 2 A bus extender attaches to the end of each rack and does
not use a rack slot.

1/0 — The number of modules depends on the CPU and the
platform used. (Refer to the list of modules that RIO
installations support, page 24.)

NOTE: Refer to the M580 Hot Standby guide for instructions to configure RIO drops in
Hot Standby systems (see Modicon M580 Hot Standby, System Planning Guide for,
Frequently Used Architectures).
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Modicon X80 Backplane Considerations

Introduction

An X80 RIO drop can have one or two racks:
1. main RIO rack: BMEXBP<++00 or BMXXBP<+0

2. extended RIO rack: only BMXXBP++0
This rack is optional in a drop and contains only I/O modules.

This rack is required in a drop and contains a BMXCRA31200, BMECRA31210, or
BMXCRA31210 EIO adapter module, a power supply, and, optionally, I/O modules.

Confirm that extended remote racks are PV 02 or later. Install modules that require

Ethernet across the backplane on the main remote rack.

fastening hole on the panel.

NOTE: The BMXCRA31200 does not support an extended RIO rack.

NOTE: The mounting screws on the left side of the backplane may be accessible
without unplugging the power supply module. Mount the backplane using the far left

Compatible Racks

Use these racks in an Modicon X80 RIO drops:
X BUS (PV 02 or later) backplanes:

o

o

o

BMXXBP0400
BMXXBP0600
BMXXBP0800
BMXXBP1200
BMXXBP1600
BMXXBP0400H
BMXXBP0600H
BMXXBP0800H
BMXXBP1200H
BMXXBP1600H

36
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+ Ethernet backplanes:
o BMEXBP0400
> BMEXBP0602
> BMEXBP0800
o BMEXBP1002(2)
> BMEXBP1200(")
o BMEXBP14024)
> BMEXBP1600©)
> BMEXBP0400H
> BMEXBP0602H
> BMEXBPO800H
o BMEXBP1002(2)
o BMEXBP1200H(")
o BMEXBP1402H®)
o BMEXBP1600H®)
(1) The 12-slot Ethernet rack has eight Ethernet-X Bus slots and four X Bus-only slots.

(2) The 10-slot Ethernet rack has eight Ethernet-X Bus slots and two X Bus-only slots.
(3) The 16-slot Ethernet rack has ten Ethernet-X Bus slots and six X Bus-only slots.

(4) The 14-slot Ethernet rack has ten Ethernet-X Bus slots and four X Bus-only slots.

Rack Selection Considerations

A BMECRA31210 performance EIO adapter module:
* can be installed on an Ethernet backplane (BMEXBP«e+¢).

+ can be installed on a PV 02 or later X-BUS backplane (BMXXBPee+¢), but it cannot
manage Ethernet modules.

+ cannot be installed in a PV 01 X-BUS backplane (BMXXBP++++) because of its keying
pin, page 22

A BMXCRA31210 or a BMXCRA31200 EIO adapter module:
» can be installed on a PV 02 or later X-BUS backplane (BMXXBPss¢*).

+ can be installed on an Ethernet backplane (BMEXBP+e+¢), but it cannot manage
Ethernet modules.
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Racks and Extensions

An Modicon X80 RIO drop can include two racks. In a 2-rack drop, the racks are linked with
two bus extender modules and a cable:

Bus Extender Module Cable
BMXXBE1000 BMXXBCe++K (0.8 to 12 m)

Consideration of a Shielded Cable with an Accessible Metal Part

Follow all local and national safety codes and standards.

AADANGER

HAZARD OF ELECTRIC SHOCK

If you cannot prove that the end of a shielded cable is connected to the local ground, the
cable must be considered as dangerous and personal protective equipment (PPE) must
be worn.

Failure to follow these instructions will result in death or serious injury.

Do not apply power to an Modicon X80 rack until connections are made at both ends of the
Ethernet cable. For example, connect the cable to both the BMECRA31210 performance
ElO adapter module and another device (adapter module) or DRS before you turn on the
power.

Refer to your system hardware reference manual for details about DRSs.

Adapter and I/O Module Installation

Introduction

Observe these guidelines when you install these adapter modules in a Modicon X80 RIO
drop):

+ BMECRA31210
+ BMXCRA31210
+ BMXCRA31200
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Order of Module Installation

Install modules in the selected rack in EcoStruxure Control Expert in this order:
1. install the adapter module
2. install a power supply
3. install /O modules

Grounding Considerations

AADANGER

ELECTRICAL SHOCK HAZARD

» Switch off the power supply at both ends of the PAC connection, and lock out and tag
out both the power sources.

* In case lock out and tag out are not available, ensure that the power sources cannot be
inadvertently switched on.

» Use suitable insulation equipment when inserting or removing all or part of this
equipment.

Failure to follow these instructions will result in death or serious injury.

NOTE: Refer to the ground connection information in Electrical installation guide.

Consideration of a Shielded Cable with an Accessible Metal Part

Follow all local and national safety codes and standards.

AADANGER

HAZARD OF ELECTRIC SHOCK

If you cannot prove that the end of a shielded cable is connected to the local ground, the
cable must be considered as dangerous and personal protective equipment (PPE) must
be worn.

Failure to follow these instructions will result in death or serious injury.
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Installation of the Adapter

EcoStruxure Control Expert automatically installs an adapter module in slot 0 in an RIO
drop.

Select a Power Supply

Power consumption depends on the reference module. For more information, refers to "RIO
Drop Adapter Modules".

The adapter module supports modules on 1 or 2 racks while the power consumption has no
relation to the number of installed rack modules.

In Modicon X80 Ethernet RIO drops, insert the power supply only in the double-wide slot to
the left of slot 0 marked CPS.

Select a power supply that suits your system requirements. These power supplies (and their
hardened versions) are supported:

Power Supply Type Modicon X80 Module
standalone +  BMXCPS2010
+  BMXCPS3020
BMXCPS2000
BMXCPS3500
BMXCPS3540
redundant *+  BMXCPS4002
BMXCPS3522
BMXCPS4022
NOTE: You can install BMXCPS4002 modules only on these dual-bus racks
(Ethernet and X bus):
BMEXBP0602
+  BMEXBP1002

Select I/0 Modules

Use the EcoStruxure Control Expert Hardware Catalog to select the /O modules needed in
your application in the main remote rack and, if available, the extended remote rack.

Mounting a Module

Use this procedure to install adapters and I/O modules in a rack:
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Step Action

1
Hold the module at an angle and mount it on the 2 hooks near the bottom of the backplane. The
figure shows the correct way to hold the module:
3 —
7  (
1

2 Swing the module up so that the connector engages the backplane connector.

3 Tighten the mounting screw so that the module is held in place on the rack.
Tightening torque: 0.4...1.5 Nem (0.30...1.10 Ibf-ft).

Replacing a Module

You can replace an Modicon X80 module at any time using another module with compatible
firmware. The replacement module obtains its operating parameters over the backplane
connection from the controller. The transfer occurs immediately at the next cycle to the

device.

NOTE: The operating parameters that the controller sends to a replacement module do
not include any parameter values that were edited in the original module using explicit
messaging SET commands.
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Installation Results

Applying power to the main local rack after the adapter module is installed can result in
either:

» Successful installation:
o Initialization is finished.
o Interconnections to other modules are validated (drop adapter module only).
* Unsuccessful installation:
o Initialization does not finish.
o Interconnections to other modules are not validated (drop adapter modules only).
You can see the status of the installation on the adapter LED display, page 18.

Setting the Location of the Ethernet Remote I/O Drop

Setting Rotary Switches

Set the location of the remote 1/O drop on the network with the rotary switches on the front of
the adapter module:

Clear IP
1430277 4040
12 4@4

S
10 ) 6 & ) 6

| Tens . Ones
Device name

NOTE: Set the rotary switches before you apply power to the module and before you
download the application.

The values you set are applied during a power cycle. If you change the switch settings after
the module has powered up, the Module Status LED, page 18 is activated and a mismatch
message is logged in the module diagnostic.

If you want to return to the original setting of a modified rotary switch (and the other switch
was changed), turn the switch until the Module Status LED goes from red to green.

New values on the rotary switches are implemented at the next power cycle. Set the value
before starting the module (valid values: 00 ... 159).
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The values on the rotary switches combine with the device prefix (for example, BMECRA _
xxx or BMXCRA_xxx) to create the device name (where xxx represents the value of the

rotary switches). The preceding figure shows the Tens switch set to 00 and the Ones switch
set to 1, for a device name of BMECRA_001.

NOTES:

» The rotary switches can be manipulated with a small flat-tipped screwdriver.
» No software is required to configure or enable the rotary switches.

Do not use the Stored and Clear IP settings on the Ones rotary switch as they do not
apply to remote I/O installations.

Remote I/O Infrastructure Cables

Cable Installation

Introduction

A copper cable connection between two consecutive RIO drops cannot exceed 100 m. A

fiber cable connection between two consecutive RIO drops cannot exceed 15 km (single
mode) or 2.5 km (multi-mode).

For more information, refer to chapter Modicon X80 Racks Installation (see Modicon X80,
Racks and Power Supplies, Hardware Reference Manual) and Electrical installation guide.
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Connections Between Devices

This figure shows the distances between RIO drops in a high-capacity daisy chain loop:

100
328
©

o

15000 m

o
= ©
|
—R

&)
®

<[ 15000 m
- i ° ‘ 9.32 mi

1 main local rack
2 copper cable (twisted pair)

3 RIO drop
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4 DRSs (with copper and optic fiber ports): This DRS extends the distance between devices
using fiber optic cable (up to 15 km).

5 fiber optic cable

6 RIO drop with a BMXNRP0200 fiber converter module

NOTE: Itis required to use shielded twisted pair CAT5e (10/100 Mbps) cables, ideally
ConneXium 490NTC-+000-- cables.

NOTICE

COMMUNICATION FAULTS
Use shielded twisted pair CAT5e (10/100 Mbps) cables to prevent communication faults.

Failure to follow these instructions can result in equipment damage.

Duplicate IP Address Checking

Introduction

NOTICE

UNINTENTIONAL EQUIPMENT BEHAVIOR

Confirm that each module has a unique IP address. Duplicate IP addresses can cause
unpredicatable module/network behavior.

Failure to follow these instructions can result in equipment damage.

Each adapter module has a single IP address for its Ethernet ports. Therefore, the address
conflict detection algorithm (duplicate IP checking) is performed based on the status (link up,
link down) of the ports.

Link Down

These conditions apply when links are lost:
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Link Status

Description

A transition has occurred
from 1 connected link to
all links down.

When no module ports are connected to a cable (all links are down), all services
are reset. For example, 1/0O connections, Modbus connections, and explicit
EtherNet/IP connections close, but low-level network services (like RSTP or
switches) are not affected. The updated Net Status LED indicates the status.

There is 1 link down and

There is no impact on services that are running in the module.

at least 1 connected link.

Link Up

These conditions apply when links are added:

Link Status Description

A transition has occurred | A duplicate IP check is performed:
from no connected links

to 1 connected link. * no duplicate: All services start.

* duplicate: /0 services stop. The BM*CRA312+0 adapter module gets new
configuration and downloads the IP configuration again. The system goes to
default IP and the 1/0 modules are set to the fallback mode.

A transition has occurred | A duplicate IP check is performed:
from at least 1 connected
link to an additional

connected link. .

* no duplicate: All services continue.
duplicate: All services stop.
NOTE: The updated Net Status LED, page 18 indicates the status.

Loss of I/O Connection

Conditions

An |/O connection can be lost to a BMECRA31210 or BMXCRA312+0 under these
conditions:

+ Performing a hot swap by replacing an adapter module with the same type.
+ There is no RIO cable connection.
+ The I/O connection is closed while the CPU is reconfigured.

Remote Adapter Fallback

In some instances, the RIO adapter module can lose 1/0O connections for a period longer
than the configured hold up time. During the hold up, the adapter tries to get IP and
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configuration parameters from the BME+58+240 CPU. If the adapter does not obtain those
parameters during the hold up time, the following happens:

* inputs: retain last known values
« outputs: set to configured fallback value

NOTE:

» Configure the hold up time on the Control Expert Parameter tab, page 55. For more
information, refer to your system planning guide.

+ In hot standby systems, this situation occurs only when the adapter module loses
the connection to the primary and secondary CPUs.

NOTE: Configure the hold up time on the Control Expert Parameter tab, page 55. For
more information, refer to your system planning guide.

Adapter Hot Swap

From the system point of view, during an adapter hot swap, when the adapter is removed
the 1/0 values go to fallback values. When the new adapter inserted and switches on and is
configured, the 1/0 values reset to their values before the hot swap.

To reduce the number of transitions after a hot swap, set the configured fallback state the
same as the default fallback state (module powered-on but not configured) before
performing the hot swap.
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Configuration and Programming with Control
Expert

Introduction

Use Control Expert to configure your remote drops for Ethernet communications.

NOTE: The device configuration procedure is valid when configuring a project with
Control Expert Classic. When you configure your device from a system project, some
commands are disabled in the Control Expert editor. In this case, you need to configure
these parameters at the system level by using the Topology Manager.

Creating a Control Expert Project

At a Glance

Use the instructions in this section to create a Control Expert project that allows
communication between the 1/0 scanner and RIO modules.

Configuring the RIO Drop

Introduction

Use these instructions to create a Control Expert project that allows communication
between the 1/0 scanner and RIO modules.

Stages

Here are the basic stages of the Control Expert configuration:

Stage Description

1 Select a CPU and a power supply to create a new Control Expert configuration. (Refer to the
Modicon M580 Hardware Reference Manual (see Modicon M580, Hardware, Reference Manual)).

2 Configure a rack assembly for the RIO drop (in this section).
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To help secure a Control Expert project against unwanted modifications, refer to the
Modicon M580 Hardware Reference Manual (see Modicon M580, Hardware, Reference

Manual).

NOTE: These instructions assume that you have a working knowledge of Control

Expert.

Rack Considerations

RIO rack considerations:

* The number of the first slot in a X80 rack is 0. Therefore, a 4-slot rack includes slot
numbers 0, 1, 2, 3.

* You can cut or copy other devices in the remote drop and paste them in any rack of the
same type, but you cannot move objects from a local rack to the drop or from a drop to
the local rack. Also, you can only perform these actions (cut, copy, paste) in the same
device editor.

Configuring a Remote Main RIO Drops

When a BME+58++40 CPU module in the main local rack Control Expert automatically
creates a second bus, the EIO Bus.

Use these instructions to configure a main RIO drop (on a EIO Bus):

Step Action Comment
1 In the Project Browser, double-click EIO Bus to | Tools > Project Browser > Structural view
see the (empty) RIO local rack. > Project > Configuration > EIO Bus
2 In the EIO Bus window, double-click the square The New Device dialog appears.
link connector to access the available racks.
3 Select a rack. This example uses the 4-slot BMEXBP0400
rack: New Device > Part Number > Modicon
M580 remote drop > Rack > BME EEP 0400.
4 In the Drop end communicator area, select a This example uses the default BMECRA31210
CRA adapter. adapter.
5 Click OK. The rack with the CRA adapter opens.
6 Click the rack to the left of the CRA adapter to This example uses a BMX CPS 2000.
add a power supply.
7 Double-click empty slots to add Modicon M580 For this example, none are added.
remote drop modules to the EIO Bus.
8 Save the file. Click File > Save.
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To add:
« another RIO drop, click the rounded square at the bottom of the dialog

» aremote drop extension rack, click the >> on the right side of the remote drop main
rack

NOTE: When physically installing a remote drop extension rack, add Bus Extender
modules and cables, page 38.

Maximum Channel Configuration

The maximum number of channels that can be configured for an X80 RIO drop is either:
+ 1024 digital channels
* 1024 channels that include 256 analog channels

The number maximum of input channels that can be configured for analog modules is 236.
In such a configuration, no other modules can be configured in the RIO drop.

NOTE: If a serial Modbus network is added to an RIO drop, take in to account the
number of channels declared when calculating the number maximum of channel
supported by the RIO drop.

Control Expert Configuration Tabs

After you have placed your modules in the remote drop, double-click the RIO drop adapter
module to see the available Control Expert configuration tabs:

™ Overview | Device DDT | ™ RSTP | SNMP | ServicePort | Parameters | ™ TimeStam..

RSTP Operational State

Bridge Priority Root(0) v

* Device DDT, page 59
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+ RSTP, page 51
+ SNMP, page 52
» Service port, page 54
The service port is not available on a drop with a BMXCRA31200 adapter.
+ Parameters, page 55
« Time Stamping, page 58

Control Expert Configuration for Ethernet RIO
Modules

At a Glance

This section describes the module configuration tabs in Control Expert. Use the parameters
on these tabs to configure services for a BM*CRA312+0 adapter module in an Ethernet RIO
drop.

RSTP Bridge Configuration

About RSTP

The RSTP service supports the inherent network communications redundancy provided by
a daisy chain loop. The RIO communications automatically find an alternate path if a
communication disruption occurs (for example, a cable breaks or a device becomes
inoperable). This service does not require you to manually enable or disable the
communication paths.

Changing RSTP parameters can affect subring diagnostics, I/O determinism, and network
recovery times.

Access the RSTP Tab

Double-click the adapter module in the Control Expert configuration to access the RSTP tab.
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Parameters

This table shows the Bridge priority parameters for the RSTP Operational State on the
Control Expert RSTP tab:

Bridge Priority Value BME+58+40 CPU Adapter Module
Root 0 default —

Backup root 4096 Reserved —

Participant 32768 — default

NOTE: Use the default value for the adapter modules.

SNMP Agent Configuration

About SNMP

An SNMP V1 agent is a software component of the SNMP service that runs on an adapter
modules and gives you access to diagnostic and management information for the modules.
You can use SNMP browsers, network management software, and other tools to access this
data.

In addition, the SNMP agent can be configured with the IP addresses of 1 or 2 devices
(typically PCs that run network management software) to be the targets of event-driven trap
messages. Such messages inform the management device of events like cold starts and the
inability of the software to authenticate a device.

Access the SNMP Tab

Double-click the adapter module in the Control Expert configuration to access the SNMP
tab.

The SNMP agent can connect to and communicate with 1 or 2 SNMP managers. The SNMP
service includes:

« authentication checking by the Ethernet adapter module of any SNMP manager that
sends SNMP requests

* management of events or traps

52 EI00000001584.13



Configuration and Programming with Control Expert

RIO Modules

SNMP Parameters

These parameters are found on the Control Expert SNMP tab:

Field Parameter Description Value
IP Address IP Address manager 1 The address of the first SNMP 0.0.0.0 ... 255.255.255.255,
managers manager to which the SNMP agent page 53
sends notices of traps.
IP Address manager 2 The address of the second SNMP
manager to which the SNMP agent
sends messages of traps.
Agent Location (SysLocation) device location 31 characters (maximum)
Contact (SysContact) information about the person to
contact for device maintenance
Enable SNMP manager unchecked (default): You can edit checked/unchecked
the Location and Contact
parameters.
checked: You cannot edit the
Location and Contact parameters.
Community Set password that the SNMP agent 15 characters (maximum)
names requires to read commands from an
Get SNMP manager (default = Public)
Trap
Security Enable “Authentication unchecked (default): not enabled. checked/unchecked
failure” trap
checked (enabled): The SNMP
agent sends a trap message to the
SNMP manager if an unauthorized
manager sends a Get or Set
command to the agent.

Offline IP Address Verification

Offline tests are done to verify that the IP addresses of the managers do not include the

following types of IP addresses:
*  multicast: 224.0.0.0 or higher
+ loopback: Any address that starts with 127
» broadcast: 255.255.255.255
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Service Port Configuration

Access the Service Port Tab

The BM*CRA31210 adapter modules have a service port that can be configured for Ethernet

communications or for port mirroring.

Double-click the adapter module in the Control Expert configuration to access the Service

Port tab.

Service Port Parameters

These parameters are on the Control Expert Service Port tab:

Field Parameter Value Comment
Service Port Enabled — Enable port and edit port parameters.

Disabled — Disable port parameters.

Service Port Access — This mode supports Ethernet communications.
Mode (default)

Mirroring — In port mirroring mode, data traffic from one or more of the other
ports is copied to this port. A connected tool can monitor and
analyze port traffic.

NOTE: In this mode, the service port acts like a read-only
port. That is, you cannot access devices (ping, connection
to Control Expert, etc.) through the service port.
NOTE: This mode is not available on the BMXCRA31200.
Access Port Service Port ETH1 You cannot edit the value in the Service Port Number field.
Configuration Number
Port Mirroring | Source Port Internal Port Ethernet traffic through the internal port
Configuration | (s)
ETH2 Ethernet traffic through the first RIO port
ETH3 Ethernet traffic through the second RIO port
Backplane Ethernet traffic through the backplane port
Port

Online Behavior

The Service Port parameters are stored in the application, however you can reconfigure
(change) the parameters in the connected mode. Values that you reconfigure in the
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connected mode are sent to the remote drop adapter module or the CPU module in explicit
messages. If the module does not respond to the explicit messages, a message appears.

NOTE: The changed values are not stored, so a mismatch can exist between the
parameters that are being used and those that are in the stored application.

NOTE: The Service Port configuration can be read and modified online using the
Service Port Control Object, page 101 CIP object.

Control Expert Configuration for RIO Drops

At a Glance

This section discusses the use of Control Expert to configure the Ethernet RIO drop and its
adapter module. Included are descriptions of the parameters on the Configuration,
Parameter, and Device DDT tabs in Control Expert.

Configuring Remote Drop Parameters

Introduction

In the Control Expert Parameters dialog, you can:

« define or verify address information about the adapter module (name, IP address, and
subnetwork mask)

+ specify a hold-up time interval
» specify I/O refresh rates

Access the Parameter Dialog

To access the Parameters dialog in Control Expert:

Step | Action Comment
1 Expand (+) EIO Bus in the Control Expert Project Browser > Configuration > EIO Bus >
Project Browser. Modicon M580 remote drop > Installed BMX/
BME rack
2 Double-click the installed adapter. The X80 performance EIO adapter window
appears.
3 Select the Parameter tab. The Parameter dialog appears.
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Parameter Descriptions

Address information parameters:

Parameter

Comment

Device Name

The name of the adapter module includes a fixed prefix and a number provided by the
rotary switch. Valid names conform to this structure: BM*CRA_xxx, where xxx equals the
3-digit value selected on the rotary switch.

When the adapter is placed in the remote drop, the number is set to the device number.
The device number does not change if the device moves to a new location.

Each adapter needs to be assigned a unique number within the application. A message
like this appears when analysis reveals a duplicate number:

{EIOBus (2) BME CRA 312 00} : Device name is not unique

IP Address

You cannot edit the IP address and sub network (mask) fields.

Sub Network

NOTE: The IP address is editable only in the IP Configuration tab of the CPU
module. The value for sub network is deduced from the CPU sub-network mask.

Edit the Device Name in Control Expert:

Step Action
1 In the X80 performance EIO adapter window, select the Parameter tab.
2 Click the Update IP/DHCP configuration hyperlink.
NOTE: An Ethernet Network table that lists all RIO drops in the system appears.
3 Double-click the arrow in the Identifier column matching the desired RIO drop in the BME+58_
ECPU_EXT column.
4 Edit the Device Name in the Identifier field to reflect the new name
5 Close the Ethernet Network window and validate your project.

Hold up time parameter:

Parameter

Comment

Hold up time

The hold up time represents the time (ms) that device outputs are maintained in their
current states after a communication disruption and before taking their fallback values:

+ default value: 1000 ms
+ valid value range: 50...65,530 ms

If you assign a hold up time value that is less than the recommended minimum value, an 1/O
module may move to its fallback state. When communications are restored, the 1/0O module
restarts and may not operate as anticipated.
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There is only one hold up time for an RIO drop (not one for each task) based on the
watchdog value.

One RPI per task = task period/2

AWARNING

UNINTENDED EQUIPMENT OPERATION

Do not configure a holdup time value that is less than the recommended minimum values,
which are:

+ for a periodic application: 6 x PAC scan time
» for a cyclic application: configured watchdog value

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Connection parameter:

Parameter Comment
Custom RPI Select this to configure the CRA->Scanner RPI setting.
CRA->Scanner RPI Inputs: The RPI is the input refresh rate at which the adapter module sends inputs

to the CPU with Ethernet I/O scanner service. The RPl is set in the subscribe field for
the adapter on the remote I/O drop:

»  periodic mode: default value = 1/2 MAST period.
* cyclic mode: default value = 1/4 watchdog timeout period.

Scanner->CRA RPI Outputs: Outputs are passed from the CPU with Ethernet I/O scanner service to the
adapter. The default values are:

» periodic mode: default value = 1.1 * MAST period.
* cyclic mode: default value = 1/4 * watchdog timeout period.

You cannot edit this value. The outputs are published synchronously or immediately
at the end of the current MAST task.

NOTE: The default value for the watchdog timer is 250 ms. If the MAST task
does not finish within the watchdog period, the process times out.

NOTE:

»  When the Periodic mode is selected for the MAST task, the Period value allows
the complete execution of the logic. (The MAST can overrun when its execution
time exceeds this value.) Valid values: 1...255 ms (increment: 1 ms).

+  When Cyclic mode is selected for the MAST task, the outputs are sent upon the
completion of the task. The Watch Dog value (10 ... 1500 ms, increment: 10 ms,
default = 250 ms) should be greater than the execution time.
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LL984 Function Blocks

Quantum RIO drops that are used in a Modicon M580 system can use LL984 function
blocks. For details, refer to Unity Pro Enhanced LL984 Block Library (see EcoStruxure™
Control Expert, UnityLL984, Block Library).

Time Stamping

RIO Drop Adapter Time Stamping Function

The BMECRA31210 and BMXCRA31210 adapter modules have a 10 ms time stamping
function. The BMXCRA31200 does not support time stamping.

Time stamping of the I/O modules starts as soon as the adapter is configured.

To configure the time stamping buffer, double-click the adapter module and click the
TimeStamping tab:

i_*;\ZJ\0.0 : BME CRA 312110.2

X80 performance EIO adapter
™ Overview |™ RSTP |I™ SNMP | ServicePort | ™ P: s | ™ TimeStamping | ™ //O objects
On buffer full On power on On STOP to RUN
(®) Stop the recording O Reset the local buffer (O Reset the local buffer
(O Overwrite buffer (® Nothing (® Nothing

The local buffer refers to the buffer in the adapter module.

To configure the BM*CRA31210, refer to BMX CRA 1604 T Variables Settings in Unity Pro
(see System Time Stamping, User Guide).

When using one or two As-i Bus BMX EIA 0200 modules with other modules in a Modicon
X80 RIO drop, the accuracy of the timestamps may be reduced.

Some examples:
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Discrete 1/10 Analog /0 | BMXEIA0100 BMXNOMO0200 Stamping Accuracy

32 Channels | 4 Channels
Dedicated High Internal NTP Server
Accuracy NTP Stamping
Server Accuracy

6 modules 1 module 0 0 10 ms 10 ms

6 modules 1 module 1 module 1 module 12 ms 22 ms

16 modules 4 modules 1 module 1 module 14 ms 24 ms

1 ms Time Stamping with BMXERT1604T

Use a BMXERT1604T time stamp module for more accurate (1 ms) time stamping.

To configure the BMXERT1604T, refer to this manual (see Modicon X80, BMXERT1604T/H
Time Stamp Module, User Manual).

For More Information about Remote Time Stamping

For more information about time stamping in a Modicon X80 RIO drop, refer to:
» System Time Stamping User Guide
« Applicative Time Stamping with Unity Pro User Guide

Device DDT Names for M580 RIO Adapters

Introduction

The Device DDT instance name can be defined manually but, when adding a module, a
default device DDT instance name (see EcoStruxure™ Control Expert, Program Languages
and Structure, Reference Manual) is defined by Control Expert.

NOTE: These instructions assume that you have already added a drop to your Control
Expert project, page 35.

Access the Device DDT Tab

In Control Expert:
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Step Action Comment
1 Expand EIO Bus in the Control Expert Project Project Browser > Project > Configuration
Browser to display the Modicon M580 remote > EIO Bus > Modicon M580 remote drop
drop
2 Double-click the installed drop adapter in the The X80 performance EIO adapter dialog
Modicon X80 Remote drop. appears.
3 Select the Device DDT tab.

The Implicit device DDT field contains a name and a type.

£ 12.110.0: BMX(CRA 312/00,2

X80 standard EIO adapter

™ Overview | ™ Device DDT l ™ RSTP | ™ SNMP | Parameters
Implicit device DDT

Name : Type :

MOD_COM_1 v
Goto details

Drop Parameters

In the Control Expert Device DDT dialog, you can configure these parameters for the RIO

drop:
Parameter Description
Implicit device DDT Name A default device DDT instance name (see EcoStruxure™ Control Expert,
Program Languages and Structure, Reference Manual) is defined by
Control Expert.
Type module type (read only)
Goto details Click this link to the Device DDT Data Editor screen.

Diagnostic Parameters

Click the Goto details button on the Device DDT screen to view the Variables tab in the
Data Editor. The bits indicates healthy (1) or unhealthy/unconfigured (0).
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View the drop diagnostic parameters in T_M_CRA_EXT _IN for an RIO drop module:

Name Type Bit | Description
I0_HEALTH_RACKO WORD — health bits of rack O: slots 0...15
NOTE: Slot 0 is on the Least
Significant bit of the Word.
I0_HEALTH_RACK1 WORD — health bits of rack 1: slots 0...15
NOTE: Slot 0 is on the Least
Significant bit of the Word.
DEVICE_NAME string[16] | — device name of the RIO drop
VERSION WORD — firmware version (Maj, Min) (4 digits
coded in BCD)
ROTARY_SWITCHES BYTE — rotary switch value at power up
CRA_STATE BYTE — 1: CRA module is idle.

2: CRA module is stopped.

3: CRA module is running.

CRA_ GLOBAL_IO_HEALTH BOOL 0 0: At least one I/0 module in the drop
DIAGNOSTIC reports bad health.
[WORD]

CCOTF_IN_PROGRESS | BOOL 1 CCOTF is in progress on the drop
managed by the CRA.

CCOTF_INVALID_CONF | BOOL 2 CCOTF is not valid on the drop managed
by the CRA.

IOPL_MISMATCH BOOL 3 The 1/O configuration in the drop differs
from that expected by the CPU for the
current application.

SWITCH_CHANGE BOOL 4 The rotary switch settings have changed
since the last power up.

This bit is reset if the rotary switch is
returned to its original setting.

DROP_COM_HEALTH BOOL 5 This bit shows the drop communication
health (set to 1 when communication is
established between the RIO drop and
the 1/O scanner).

REDUNDANT_POWER_ | BOOL 6 This bit shows that redundant power is
SUPPLY_STATUS present (1) or not present (0).

CYCLE_CURR_TIME UINT — This word indicates the execution time of
the last CRA cycle.

It has values between [0.65535] with a
resolution of 0.01 ms, therefore, the last
cycle time is between [0.655] ms.
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Name

Type

Bit

Description

CYCLE_MAX_TIME

UINT

This word indicates the longest CRA
cycle execution time since the last start.

It has values between [0.65535] with a
resolution of 0.01 ms, therefore, the
longest cycle time is between [0,655] ms.

CYCLE_MIN_TIME

UINT

This word indicates the shortest CRA
cycle execution time since the last start.

It has values between [0.65535] with a
resolution of 0.01 ms, therefore, the
shortest cycle time is between [0.655]
ms.

TIME_STAMP_RECORDS

UINT

This word contains the number of
records available in the local drop event
buffer.

TS_DIAGNOSTIC
FLAGS (WORD)

TIME_VALID

BOOL

The time is valid and synchronized.

CLOCK_FAILURE
CLOCK_NOT_SYNC

BOOL

If

* bit1=1&bit2=1, since power-on
CRA adapter has not received a
response from NTP server.

* bit1=0&bit2 =1, CRA adapter
has received a response from NTP
server in the past but is not
currently receiving the time from
the NTP server

+  bit1=0&Dbit2=0, Time is valid,
CRA adapter is receiving
responses from the NTP server.

BUFF_FULL

BOOL

The local drop event buffer is full.

TS_BUF_FILLED_PCTAGE

BYTE

This byte reports the percentage of the
local drop event buffer filled (0...100).

TS_EVENTS_STATE

BYTE

Refer to Main States, page 64.

ETH_STATUS
(BYTE)

PORT1_LINK

BOOL

0 = Port 1 (ETH1) link is down.

1="Port 1 (ETH1) link is up.

PORTZ2_LINK

BOOL

0 = Port 2 link is down.

1 ="Port 2 link is up.

PORT3_LINK

BOOL

0 = Port 3 link is down.

1 ="Port 3 link is up.

ETH_BKP_PORT_LINK

BOOL

0 = Ethernet backplane link is down.

1 = Ethernet backplane link is up.
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Name Type Bit | Description
RPI_CHANGE BOOL 4 RPI change: EtherNet/IP RPI change is
in progress (during CCOTF).
REDUNDANCY_ BOOL 6 1 = Redundant owner is present.
OWNER
0 = Redundant owner is not present.
GLOBAL_STATUS BOOL 7 0 = At least 1 service is not operating
NOTE: Refer to the normally.
Ll 1 = All services are operating normall
byte below. - : perating y-
SERVICE_STATUS | RSTP_SERVICE BOOL 0 0 = RSTP service is not operating
(BYTE) normally.
1 = RSTP service is operating normally
or disabled.
SNTP_SERVICE BOOL 1 0 = SNTP service is not operating
(reserved) normally.
1 = SNTP service is operating normally
or disabled.
PORT502_SERVICE BOOL 2 0 = Port 502 service is not operating
normally.
1 = Port 502 service is operating
normally or disabled.
SNMP_SERVICE BOOL 3 0 = SNMP service is not operating
normally.
1 = SNMP service is operating normally
or disabled.
ETH_BKP_FAILURE BOOL 5 0 = Ethernet backplane hardware status
is not OK.
1 = Ethernet backplane hardware status
is OK.
ETH_BKP_ERROR BOOL 6 0 = An error is detected on the Ethernet
backplane.
1 = No errors are detected on the
Ethernet backplane.
ETH_PORT_ These combined 2-bit WORD 1/0 | Ethernet backplane port 1 function
STATUS (BYTE) values indicate the port
conditions. 3/2 | Ethernet port 1 RSTP role
5/4 | Ethernet backplane port 2 function
7/6 | Ethernet port 2 RSTP role
9/8 | Ethernet backplane port 3 function
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Name Type Bit | Description
11/ | Ethernet port 3 RSTP role
10
12/ | Ethernet backplane port 4 function
13
14/ | Ethernet port 4 RSTP role
15

port function — 0 disabled

1 access port

port mirror

2
3 RIO network port
0

RSTP role — alternate
1 backup
2 designated
3 root
NTP_UPDATE UINT — elapsed time (100 ms) since last update
from NTP server
MAX_PACKET_INTERVAL UINT — maximum packet interval (ms) for output
packets (from scanner to adapter)
IN_BYTES UINT — number of bytes (octets) received on
interface
IN_ERRORS UINT — number of inbound packets that contain
detected errors
OUT_BYTES UINT — number of bytes (octets) sent on
interface
OUT_ERRORS UINT — number of outbound packets that contain
detected errors
SOE_UNCERTAIN BOOL — The sequence of events SOE in the local

drop event buffer is not known. The
SOE_UNCERTAIN is reset when the
sequence of events is OK.

Main States of the Time Stamp Source

The TS_EVENTS_STATE byte reports the main state of the source of the time stamp
events:
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Byte Value (hex) Description

20 wait for client

31 ValuesSynchro requested and waiting for buffer below the threshold
32 ValuesSynchro started

40 event Stamping

Device DDT Types for I/O Modules

Refer to the following user guides for specific I/O module device DDT types:

1/0 Module User Guide Reference

Modicon X80 discrete Modicon M340 Using Unity Pro Discrete Input/Output Modules User Manual
input/output

Motdicton X80 analog input/ | Modicon M340 with Unity Pro Analog Input/Output Modules User Manual
outpu

BMXEHC0800 Modicon M340 with Unity Pro Counting Module BMXEHC0800 User Manual
BMXEHC0200 Modicon M340 with Unity Pro Counting Module BMXEHC0200 User Manual
BMXNOMO0200 Modicon M340 with Unity Pro Serial Link User Manual

BMXERT1604T BMXERT1604T M340 ERT Module User Manual
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Implicit and Explicit Messaging
Explicit Messaging

Use of Explicit Messaging

The CPU uses explicit messaging for request-and-reply communications for non-real-time
information (like configuration and diagnostic data).

EtherNet/IP uses the TCP/IP and UDP/IP protocols to implement explicit messaging over
the high capacity daisy chain ring used in a Modicon M580 system.

Implicit /0 Exchanges

Task Management

This topic explains implicit I/O and the relationship between the task configuration and the
RIO implicit exchanges.

Implicit messaging maintains open connections for real-time communications of a
predefined nature between consumers and producers. Implicit I/O exchanges contain
control data and a connection identifier.

EtherNet/IP uses the TCP/IP and UDP/IP protocols to implement implicit messaging.

M580 Implicit Messaging Communication Parameters

M580 implicit messaging communication parameters are automatically configured when you
add a module to a project. To complete the configuration of implicit I/O exchanges to RIO
modules, you need to assign a task to each I/0O module. The availability of tasks that you
can assign to a module — MAST, FAST, AUX0 or AUX1 — depends on:

 the location of the module (see EcoStruxure™ Control Expert, Program Languages and
Structure, Reference Manual) (i.e. if it is placed on a local rack, is part of an RIO drop,
or is a distributed device), and

» the tasks supported by the adapter module used in an RIO drop, page 14.

66 EI00000001584.13



Implicit and Explicit Messaging RIO Modules

Access the MAST Configuration

To view the Properties of MAST:

Step Action

1 Go to the Properties of MAST dialog box in Control Expert (Tools > Project Browser > Project

> Program > Tasks > MAST).

2 Right-click MAST > Properties to open the Properties of MAST dialog.

3 Configure the parameters as needed.

Access the FAST Configuration

To view the Properties of FAST:

Step Action

1 Go to the Properties of FAST dialog box in Control Expert (Tools > Project Browser > Project >
Program > Tasks > FAST).

2 Right-click FAST > Properties to open the Properties of FAST dialog.

3 Configure the parameters as needed.

Access the AUX0 Configuration

To view the Properties of AUXO:

Step Action

1 Go to the Properties of AUXO0 dialog box in Control Expert (Tools > Project Browser > Project >
Program > Tasks > AUXO0).

2 Right-click AUX0 > Properties to open the Properties of AUXO dialog.

3 Configure the parameters as needed.

Access the AUX1 Configuration

To view the Properties of AUX1:
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Step Action

1 Go to the Properties of AUX1 dialog box in Control Expert (Tools > Project Browser > Project >

Program > Tasks > AUX1).

Right-click AUX1 > Properties to open the Properties of AUX1 dialog.

3 Configure the parameters as needed.

Periodic and Cyclic Modes

The effect that periodic and cyclic modes have on implicit I/O is explained in the description
of the connection parameters, page 55.

I/0 Management for Implicit /0 Exchanges

There are no state RAM addresses for (€)X80 1/0 modules in RIO drops in an M580 system.

NOTE: State RAM is supported in Unity Pro v11.0 (and later) in M580 applications that
contain Quantum RIO drops.
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Diagnostics

Overview

This chapter describes the diagnostics for the Modicon M580 modules. For details on
diagnostics at the system level, refer to the systems diagnostics topic in your system
planning guide.

Service Port Management

Service Port Configuration

Introduction

A BME<+58+40 RIO scanner module and an RIO adapter modules (BM*CRA31210) support
the configuration of the SERVICE port without requiring you to rebuild or download your
application.

Adapter Modules

You can send explicit messages with an EtherNet/IP tool for the configuration of the
SERVICE port on the BM*CRA31210 modules. For details, refer to information about
EtherNet/IP CIP objects in your system hardware reference manual and SERVICE port
configuration for adapter modules, page 54.

Cycling Power

The online configuration of the SERVICE port is volatile. The following may result when
power is cycled to the adapter module while the application is being applied:

» The configuration can be lost.
» The configuration in the application can be applied to the SERVICE port.
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Diagnostics Available through the CPU

System Diagnostics

Introduction

System diagnostics are performed by using:
+ system bits (%S) and system words (%SW)
* Modbus/TCP, page 72 or EtherNet/IP CIP, page 73 requests
+ diagnostic parametersinthe T CRA EXT IN, page 60 DDT.

RIO Drop Diagnostics

Certain Ethernet RIO drop diagnostics are accessible for the entire drop within system bits
and words in the PAC (%S, %SW). Each drop is animated with a health bit display of the
health bit status for:

* adrop node
* amodule in a remote drop

The CPU I/O scanner monitors RIO drops and module health. The adapter modules in the
RIO drops transmit detected errors in the drop modules to the CPU via implicit messages,
page 66. The detected errors are stored in the global diagnostic buffers of the CPU and in
the diagnostic buffer of the individual drop modules.

The CPU updates the detected error buffers. Health bits are updated in the CPU only if the
adapter of the concerned drop communicates with the CPU. If these modules cannot
communicate, the concerned health bits are set to 0.

System Bits and Words

This table describes the system bits and words for M580 that represent detected errors:

System Bits/Words Symbol Description

%S117 EIOERR detected RIO error

%SW101 EIO_CCOTF_COUNT CCOTF counting status register
%SW108 FORCED_DISCRETE_COUNT forced bit counting status register
%SW109 FORCED_ANALOG_COUNT forced bit counting status register
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NOTE: Refer to the Unity Pro Program Languages and Structure Reference Manual
complete explanations of the system bits and words.

Ethernet Diagnostics Using MB/TCP Requests

Ethernet Diagnostics from the BM*CRA312+0 adapter:

Data rate on the Ethernet TCP/IP network()2): This is the link speed in Mbps.

Ethernet Activity information(")(2); This is the counter of Ethernet frames transmitted and
received by the BM*CRA312+0 adapter.

Ethernet link status(): For each Ethernet port, is its link up (1) or down (2). See also
Duplicate IP Address Checking, page 45.

redundancy_owner: This provides information about the presence of a redundant owner
in Hot Standby systems.

redundant_power_supply_status: This provides information about the redundancy of
the power supply.

Port 502 Status(): Modbus port

Half / Full duplex mode(")): This is the mode of the RIO network.
Ethernet backplane configuration error(): This is set 1 if either:

o there is a detected error in the Ethernet backplane configuration

o the Ethernet backplane firmware version is lower than the one required by the
application

Legend:
(1) Accessible through explicit Modbus/TCP, page 72 requests

(2) Accessible through explicit EtherNet/IP CIP, page 73 requests

Viewing Diagnostics in Control Expert

The bus editor in Control Expert uses color animation to display the status of each drop,
rack, or module on the EIO Bus.

The slot number of the drop/rack/module appears in red when a detected error is associated
with that slot.

For a module, the red display indicates the module is missing, inoperable, or improperly
configured.

This table relates a drop, rack, or module to its language object:
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Drop Status Language Object i j

drop (d) %SWi.j 152 +[(d-1)/31] (d-1)/31
BM+« CRA 312 <0 rack (r), drop (d) %SWi 641 +[(d-1)*2] +r

module (m), rack (r), drop (d) %SWi.j 641 +[(d-1)2] +r 30-m

NOTE: Remember:
» The slots in a drop are numbed 0...n.
* The rack numbers are used in remote drops:
o 0: main rack in the RIO drop
o 1: extended rack in the RIO drop

Diagnostics Available through Modbus/TCP

Modbus Diagnostic Codes

Supported Diagnostic Codes

The following Modicon M580 modules support these Modbus diagnostic codes:
» CPU with Ethernet I/O scanner service
* RIO adapter modules:
o BMECRA31210
o BMXCRA31210
o BMXCRA31200

Diagnostic
Function code 8, subcode 22: Modbus function code 08 provides a variety of diagnostic
functions:
Operation Diag. Description
Code Control
0x01 0x0100 Network diagnostic data
0x0200 Read the Ethernet port diagnostic data from the switch manager.
0x0300 Read the Modbus TCP/port 502 diagnostic data from the Modbus server.
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Operation Diag. Description
Code Control
0x0400 Read the Modbus TCP/port 502 connection table from the Modbus server.
0x07F0 Read the data structure offset data from the Modbus server.
0x02 0x0100 Clears the basic network diagnostic data.
NOTE: Only specific parameters of basic network diagnostic data are used to clear
requests.
0x0200 Clears the Ethernet port diagnostic data.
NOTE: Only specific parameters of basic network diagnostic data are used to clear
requests.
0x0300 Clears the Modbus TCP/port 502 diagnostic data.

NOTE: Only specific parameters of Modbus port 502 diagnostic data are used to
clear requests.

0x0400 Clears the Modbus TCP/port 502 connection table.

NOTE: Only specific parameters of Modbus port 502 connection data are used to
clear requests.

0x03 0 Clears the diagnostic data.
NOTE: Only specific parameters of each diagnostic data are used to clear requests.

Diagnostics Available through EtherNet/IP CIP
Objects

At a Glance

M580 applications use CIP within a producer/consumer model to provide communication
services in an industrial environment. This section describes the available CIP objects for
X80 modules in an M580 system.

About CIP Objects

Overview

The remote 1/0O adapter module can access CIP data and services located in connected
devices. The CIP objects and their content depend on the design of each device.
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CIP object data and content are exposed and accessed hierarchically in the following nested
levels:

Object
I—.» Class ——pm=Class Attributes
L>Instance —= |nstance Attributes

NOTE: You can use explicit messaging to access these items:

» Access a collection of instance attributes by including only the class and instance
values for the object in the explicit message.

» Access a single attribute by adding a specific attribute value to the explicit message
with the class and instance values for the object.

When the local slave service for the adapter is activated, remote devices on the remote 1/0
drop can send explicit messages to the CIP object structure of the module. Then you can
access module data or execute module commands.

This chapter describes the CIP objects that the adapter exposes to remote devices.

Identity Object

Class ID

01

Instance IDs

The Identity object presents 2 instances:
* O:class
+ 1:instance

Attributes

Identity object attributes are associated with each instance, as follows:

Instance ID = 0 (class attributes):
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Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported

— = not supported

Instance ID = 1 (instance attributes):

Attribute ID Description Type GET SET
hex dec
01 01 Vendor ID UINT X —
02 02 Device type UINT X —
03 03 Product code UINT X —
04 04 Revision STRUCT X —
Major USINT
Minor USINT
05 05 Status Word X —
bit 2:

0x01=the module is configured

bits 4-7:

0x03=no I/0O connections established
0x06=at least 1 1/O connection in run mode

0x07=at least 1 1/0O connection established,

all in IDLE mode
06 06 Serial number UDINT X —
07 07 Product name STRING X —
18 24 Modbus identity STRUCT X —
X = supported
— = not supported
Services

The Identity object supports the following services:
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Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns:
all class attributes (instance = 0)
instance attributes 1 to 7 (instance = 1)
OE 14 Get_Attribute_Single X X Returns the value of the specified attribute.
X = supported
— = not supported
Assembly Object
Overview

You can send an explicit message to the Assembly object only when no other connections
have been established that read from or write to this object. For example, you can send an
explicit message to the Assembly object if a local slave instance is enabled, but no other

module is scanning that local slave.

Class ID

04

Instance IDs

Attributes

The Assembly object presents the following instance identifiers:

e 0:class
« 101,102, 111, 112, 121, 122: instance

Instance ID = 0 (class attributes):

The Assembly object consists of the following attributes:
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Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
03 Number of Instances X —
X = supported

— = not supported

Instance attributes:

Instance ID Attribute ID Description Type GET SET
101 03 Local slave 1: T->O input data Array of BYTE X —
102 Local slave 1: O>T Array of BYTE X X
111 Local slave 2: T->O input data Array of BYTE X —
112 Local slave 2: O>T Array of BYTE X X
121 Local slave 3: T->O input data Array of BYTE X —
122 Local slave 3: O>T Array of BYTE X X
X = supported
— =not supported

Services

The Assembly object supports the following services:
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Service ID Description Class | Instance Notes

hex dec

OE 14 Get_Attribute_Single X X Returns the value of the specified attribute.
10 16 Set_Attribute_Single( — X Returns these values:

OE = attribute not settable: assembly is not o->T
type

OF = permission denied: assembly is being used
by an active connection

13 = config too small: the Set_Attribute_Single
command contains partial data

15 = data too big: the Set_Attribute_Single
command contains too much data

(1) When valid, the size of the data written to the Assembly object using the Set_Attribute_Single service equals the size
of the Assembly object as configured in the target module.

X = supported

— = not supported

Connection Manager Object

Class ID

06

Instance IDs

The Connection Manager object presents 2 instance values:
* 0O:class
« 1:instance

Attributes

Connection Manager object attributes are associated with each instance, as follows:

Instance ID = 0 (class attributes):

78 EI00000001584.13



Diagnostics RIO Modules
Attribute ID Description GET SET
01 Revision X —

02 Max Instance X —

X = supported

— = not supported

Instance ID = 1 (instance attributes):

Attribute ID Description Type GET SET Value

hex dec

01 01 Open Requests UINT X X Number of Forward Open
service requests received.

02 02 Open Format Rejects UINT X X Number of Forward Open
service requests that were
rejected due to bad format.

03 03 Open Resource UINT X X Number of Forward Open

Rejects service requests that were
rejected due to lack of
resources.

04 04 Open Other Rejects UINT X X Number of Forward Open
service requests that were
rejected for reasons other
than bad format or lack of
resources.

05 05 Close Requests UINT X X Number of Forward Close
service requests received.

06 06 Close Format UINT X X Number of Forward Close

Requests service requests that were
rejected due to bad format.

07 o7 Close Other Requests | UINT X X Number of Forward Close
service requests that were
rejected for reasons other
than bad format.

08 08 Connection Timeouts UINT X X Total number of connection
timeouts that occurred in
connections controlled by
this connections manager

09 09 Connection Entry List STRUCT X — 0 (Unsupported optional
item)

0B 11 CPU_Utilization UINT X — 0 (Unsupported optional
item)

oC 12 MaxBuffSize UDINT X — 0 (Unsupported optional
item)
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Attribute ID Description Type GET SET Value
hex dec
oD 13 BufSize Remaining UDINT X — 0 (Unsupported optional
item)
X = supported
— = not supported
Services

The Connection Manager object supports the following services:

Service ID Description Class | Instance Notes

hex dec

01 01 Get_Attributes_All X X Returns the value of all attributes.

OE 14 Get_Attribute_Single X Returns the value of the specified attribute.
X = supported

— = not supported

Quality of Service (QoS) Object

Overview

The QoS object implements the Differentiated Services Code Point (DSCP or DiffServe)
values to prioritize Ethernet messages.

Class ID

48 (hex), 72 (decimal)

Instance IDs

The QoS object presents 2 instance values:

e 0O:class

« 1:instance
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Attributes
The QoS object consists of the following attributes:
Instance ID = 0 (class attributes):
Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported
— = not supported
Instance ID = 1 (instance attributes):
Attribute ID Description Type GET SET Value
04 DSCP Urgent USINT X X For CIP transport class 0/1
Urgent priority messages,
default value = 55.
05 DSCP Scheduled USINT X X For CIP transport class 0/1
Scheduled messages,
default value = 47.
06 DSCP High USINT X X For CIP transport class 0/1
High priority messages,
default value = 43.
07 DSCP Low USINT X X For CIP transport class 0/1
Low priority messages,
default value = 31.
08 DSCP Explicit USINT X X For CIP explicit messages
(transport class 2/3 and
UCMM), default value = 27.
X = supported
— = not supported

NOTE: A change in the instance attribute value takes effect on device restart, for

configurations made from flash memory.

Services

The QoS object supports the following services:
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Service ID Description Class Instance
hex dec

OE 14 Get_Attribute_Single X X

10 16 Set_Attribute_Single — X

X = supported

— = not supported

TCPI/IP Interface Object

Class ID

F5 (hex), 245 (decimal)

Instance IDs

The TCP/IP interface object presents 2 instance values:
+ O:class
+ 1:instance

Attributes

TCP/IP interface object attributes are associated with each instance, as follows:

Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported

— = not supported

Instance ID = 1 (instance attributes):
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Attribute ID Description Type GET SET Value
01 Status DWORD X — 0x01
02 Configuration capability DWORD X — 0x01 = from BootP
0x11 = from flash
0x00 = other
03 Configuration control DWORD X X 0x01 = out-of-box default
04 Physical Link Object STRUCT X —
Path size UINT
Path Padded
EPATH
05 Interface Configuration STRUCT X X 0x00 = out-of-box default
IP address UDINT
Network mask UDINT
Gateway address UDINT
Name server UDINT
Name server 2 UDINT
Domain name STRING
06 Host name STRING X —
X = supported
— = not supported
Services
The TCP/IP interface object supports the following services:
Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all
attributes.
OE 14 Get_Attribute_Single X X Returns the value of the
specified attribute.
10 16 Set_Attribute_Single! — X Sets the value of the specified
attribute.
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Service ID Description Class Instance Notes

hex dec

X = supported

— = not supported

1. The Set_Attribute_Single service can execute only when these preconditions are satisfied:
»  Configure the Ethernet communication module to obtain its IP address from flash memory.
*  Confirm that the PAC is in stop mode.

Ethernet Link Object

Class ID

F6 (hex), 246 (decimal)

Instance IDs

The Ethernet Link object presents the following instance values (for an BMECRA31210):
* 0O:class
* 1:port (ETH1, page 17)
+ 2:port (ETH2)
+ 3:port (ETH3)
* 4: port (Internal backplane port 255)

Attributes

The Ethernet Link object presents the following attributes:

Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
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Attribute ID Description GET SET
03 Number of Instances X —
X = supported

— = not supported

Instance ID = 1 (instance attributes):

Attribute ID Description Type GET SET Value
hex dec
01 01 Interface speed UDINT X — Valid values include:

0, 10000000, 100000000

02 02 Interface flags DWORD X — Bit 0: link status
0 = Inactive

1 = Active

Bit 1: duplex mode
0 = half duplex
1 = full duplex

Bits 2—4: negotiation status

3 = successfully negotiated
speed and duplex

4 = forced speed and link

Bit 5: manual setting requires
reset

0 = automatic

1 = device need reset

Bit 6: local hardware detected
error

0 =no event

1 = event detected

03 03 Physical Address ARRAY of X — module MAC address
6 USINT
04 04 Interface Counters STRUCT of | X —
In bytes UDINT bytes received on the interface
In Ucast packets UDINT unicast packets received on the
interface
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Attribute ID Description Type GET SET Value
hex dec
In NUcast packets UDINT non-unicast packets received on
the interface
In discards UDINT inbound packets received on the
interface, but discarded
In detected errors UDINT inbound packets with detected
errors (does not include in
discards)
In Unknown UDINT inbound packets with unknown
Protocals protocol
Out bytes UDINT bytes sent on the interface
Out Ucast packets UDINT unicast packets sent on the
interface
Out NUcast packets UDINT non-unicast packets sent on the
interface
Out discards UDINT outbound packets discarded
Out detected errors UDINT outbound packets with detected
errors
05 05 Media Counters STRUCT of | X —
Detected alignment UDINT frames that are not an integral
errors number of bytes in length
Detected FCS errors | UDINT incorrect CRC: frames received
do not pass the FCS check
Single collisions UDINT successfully transmitted frames
that experienced exactly 1
collision
Multiple collisions UDINT successfully transmitted frames
that experienced more than 1
collision
SQE test errors UDINT number of times the SQE test
error is generated
Deferred UDINT frames for which first
transmissions transmission attempt is delayed
because the medium is busy
Late collisions UDINT number of times a collision is
detected later than 512-bit times
into the transmission of a packet
Excessive collisions UDINT frames that do not transmit due

to excessive collisions
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Attribute ID

Description

Type

GET

SET

Value

hex

dec

MAC transmit
detected errors

UDINT

Frame too long

UDINT

frames that do not transmit due
to a detected internal MAC
sublayer transmit detected error

frames received that exceed the
maximum permitted frame size

05

05

Detected MAC
receive errors

UDINT

Carrier sense
detected errors

UDINT

frames not received on an
interface due to a detected
internal MAC sublayer detected
receive error

times that the carrier sense
condition was lost or not
asserted when attempting to
transmit a frame

06

06

Interface Control

STRUCT of

Control bits

WORD

Forced interface
speed

UINT

API of the connection

Bit 0: Auto-negotiation
0 = disabled
1 =enabled

Note: When auto-negotiation is
enabled, 0x0C (object state
conflict) is returned when
attempting to set either:

« forced interface speed
» forced duplex mode

Bit 1: forced duplex mode (if
auto-negotiation bit = 0)

0 = half duplex

1 = full duplex

Valid values include:
10000000, 100000000

Note: Attempting to set any
other value returns the detected
error 0x09 (invalid attribute
value)

EI00000001584.13

87



RIO Modules

Diagnostics

Attribute ID Description Type GET SET Value

hex dec

10 16 Interface label SHORT_ X — A fixed textual string identifying

STRING the interface that should include

‘internal’ for internal interfaces.
Maximum number of characters
is 64.

X = supported

— = not supported

Services
The Ethernet Link object supports the following services:

Service ID Description Class Instance

hex dec

01 01 Get_Attributes_All X X

10 16 Set_Attribute_Single — X

OE 14 Get_Attribute_Single X X

4C 76 Get_and_Clear — X

X = supported

— = not supported

EtherNet/IP Interface Diagnostics Object

Class ID

350 (hex), 848 (decimal)

Instance IDs

The EtherNetP/IP Interface object presents 2 instance values:

e 0O:class

« 1:instance
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Attributes

EtherNet/IP Interface Diagnostics object attributes are associated with each instance, as

follows:

Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported

— = not supported

Instance ID = 1 (instance attributes):

Attribute ID Description Type GET | SET | Values
01 Protocols Supported UINT X — 0: supported1: not supported
* Bit 1: Modbus TCP/IP
* Bit2: Modbus SL
* Bits 3-15: Reserved
02 Connection STRUCT X —
Diagnostics of
Max CIP I/O UINT Number of Class 1 connections opened since
connections opened the last reset
Current CIP 1/0 UINT Number of Class 1 connections currently
connections opened.
Max CIP explicit UINT Number of Class 3 connections opened since
connections opened the last reset.
Current CIP explicit UINT Number of Class 3 connections currently
connections opened.
CIP connections UINT Increments each time a Forward Open is not

opening detected errors

CIP connections timeout | UINT
detected errors

Max EIP TCP UINT
connections opened

successful (Originator and Target).

Increments when a connection times out
(Originator and Target).

Number of TCP connections (used for EIP as
client or server) opened since the last reset.

Current EIP TCP UINT Number of TCP connections (used for EIP as
connections client or server) currently open.

03 1/0 Messaging STRUCT X X
Diagnostics of
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Attribute ID Description Type GET | SET | Values
I/0 production counter UDINT Increments each time a Class 0/1 message is
sent.
I/0 consumption counter | UDINT Increments each time a Class 0/1 message is
received.
I/0 productions send UINT Increments each time a Class 0/1 message is
detected error counter not sent.
1/O consumptions UINT Increments each time a consumption is
receive detected error received with a detected error.
counter
04 Explicit Messaging STRUCT X X
Diagnostics of
Class 3 message sent UDINT Increments each time a Class 3 message is
counter sent (client and server).
Class 3 message UDINT Increments each time a Class 3 message is
received counter received (client and server).
UCMM message UDINT Increments each time an UCMM message is
received counter sent (client and server).
UCMM message UDINT Increments each time an UCMM message is
received counter received (client and server).
X = supported
— = not supported
Services
The EtherNet/IP Interface Diagnostics object supports the following services:
Service ID Description Class Instance Notes
hex dec
01 01 Get_Attributes_All X X Returns the value of all attributes.
OE 14 Get_Attribute_Single — X Returns the value of the specified attribute.
4C 76 Get_and_Clear — X Returns and clears the values of all instance
attributes.
X = supported
— = not supported
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I/0 Connection Diagnostics Object

Class ID

352 (hex), 850 (decimal)

Instance IDs

The 1/0 Connection Diagnostics object presents the following instance values:
* O:class
+ 1...256: instances

NOTE: The Instance ID number = the Connection ID. For M580 specifically, you can
look up the Connection ID on the DTM Device List screen.

Attributes

I/O Connection Diagnostics object attributes are associated with each instance, as follows:

Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported

— = not supported

Instance ID = 1 to 256 (instance attributes):

Attribute ID Description Type GET | SET | Value
01 1/0 Communication STRUCT X X
Diagnostics of
1/0 production counter UDINT Increments at each production.
1/0 consumption counter UDINT Increments at each consumption.
1/0 production sent detected UINT Increments each time a production is
error counter not sent.
1/0 consumption received UINT Increments each time a consumption is
detected errors counter received with a detected error.
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Attribute ID Description Type GET | SET | Value
CIP connection timeout UINT Increments when a connection times
detected errors out.
CIP connection opening UINT Increments each time a connection is
detected errors unable to open.
CIP connection state UINT State of the connection bit
CIP last detected error general | UINT General status of the last error
status detected on the connection
CIP last detected error UINT Extended status of the last error
extended status detected on the connection
Input communication status UINT Communication status of the inputs
(see table, below)
Output communication status UINT Communication status of the outputs
(see table, below)
02 Connection Diagnostics STRUCT X X
of
Production connection ID UDINT Connection ID for production
Consumption connection ID UDINT Connection ID for consumption
Production RPI UDINT RPI for production (ms)
Production API UDINT API for production
Consumption RPI UDINT RPI for consumption
Consumption API UDINT API for consumption
Production connection UDINT Connection parameters for production
parameters
Consumption connection UDINT Connection parameters for
parameters consumption
NOTE: Refer to the ODVA
standard:The CIP Networks
LibraryVol. 1: Common Industrial
ProtocolPublication number:
PUB00001
Local IP UDINT —
Local UDP port UINT —
Remote IP UDINT —
Remote UDP port UINT —
Production multicast IP UDINT Multicast IP address used for
production. If unused, it is 0.
Consumption multicast IP UDINT Multicast IP address used for
consumption. If unused, itis 0.
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Attribute ID Description

Type

GET

SET

Value

Protocols supported

UDINT

Protocols supported on the connection:

1 = EtherNet/IP

X = supported

— = not supported

The following values describe the structure of the instance attributes: CIP connection state,
Input Communication status, and Output communication status:

Bit Number Description Values

15..3 Reserved 0

2 Idle 0 = no idle notification
1 = idle notification

1 Consumption inhibited 0 = consumption started
1 = no consumption

0 Production inhibited 0 = production started
1 = no production

Services

The EtherNet/IP Interface Diagnostics object supports the following services:

Service ID Description Class Instance Notes

hex dec

01 01 Get_Attributes_All X X Returns the value of all
attributes.

OE 14 Get_Attribute_Single — X Returns the value of the
specified attribute.

4C 76 Get_and_Clear — X Returns and clears the values of
all instance attributes.

X = supported

— = not supported
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EtherNet/IP Explicit Connection Diagnostics Object

Overview

The EtherNet/IP Explicit Connection Diagnostics object presents the instances, attributes
and services described below.

Class ID

353 (hex), 851 (decimal)

Instance IDs

The EtherNet/IP Explicit Connection Diagnostics object presents two instance values:
+ O:class
* 1...N:instance (N = maximum concurrent number of explicit connections)

Attributes

EtherNet/IP Explicit Connection Diagnostics object attributes are associated with each
instance, as follows:

Instance ID = 0 (class attributes):

Attribute ID hex Description Value GET SET
01 Revision 1 X —
02 Max Instance 0..N X —
X = supported

— = not supported

Instance ID = 1 to N (instance attributes):

Attribute ID Description Type GET | SET | Value

hex

01 Originator connection ID UDINT X — Originator to target connection ID
02 Originator IP UINT X —
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Attribute ID Description Type GET | SET | Value
hex
03 Originator TCP Port UDINT X —
04 Target connection ID UDINT X — Target to originator connection ID
05 Target IP UDINT | X —
06 Target TCP Port UDINT | X —
07 Msg Send Counter UDINT X — Incremented each time a Class 3
CIP message is sent on the
connection
08 Msg Receive counter UDINT | X — Increments each time a Class 3 CIP
message is received on the
connection
X = supported
— = not supported
Services

The EtherNet/IP Explicit Connection Diagnostics object performs the following services
upon the listed object type:

Service ID Description Class Instance Notes

hex dec

01 01 Get_Attributes_All X X Returns the value of all attributes.
X = supported

— = not supported

EtherNet/IP Explicit Connection Diagnostics List Object

Overview

The EtherNet/IP Explicit Connection Diagnostics List object presents the instances,
attributes and services described below.
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Class ID

354 (hex), 852 (decimal)

Instance IDs

The EtherNet/IP Explicit Connection Diagnostics List object presents two instance values:
+ O:class
* 1:instance

Attributes

EtherNet/IP Explicit Connection Diagnostics List object attributes are associated with each
instance, as follows:

Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision X —
02 Max Instance X —
X = supported

— = not supported

Instance ID = 1 to 2 (instance attributes):

Attribute ID Description Type GET | SET | Value
01 Number of connections UINT X — Total number of opened explicit
connections
02 Explicit Messaging ARRAY of | X —
Connections Diagnostic | STRUCT
List
Originator connection ID | UDINT O->T connection ID
Originator IP UINT —
Originator TCP port UDINT —
Target connection ID UDINT T->O connection ID
Target IP UDINT —
Target TCP port UDINT —
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Attribute ID Description Type GET | SET | Value
Msg Send counter UDINT Increments each time a Class 3 CIP
message is sent on the connection
Msg Receive counter UDINT Increments each time a Class 3 CIP
message is received on the
connection
X = supported
— = not supported
Services

The EtherNet/IP Explicit Connection Diagnostics object performs the following services
upon the listed object types:

Service ID Description Class Instance Notes

hex dec

01 01 Get_Attributes_All X — Returns the value of all
attributes.

08 08 Create X — —

09 09 Delete — —

4B 75 Explicit_Connections_Diagnostic_Read — —

X = supported

— = not supported

RSTP Diagnostics Object

Class ID

355 (hex), 853 (decimal)

Instance IDs

The RSTP Diagnostics object presents these instance values:

e O:class

* 1... N:instance
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Attributes
RSTP Diagnostics object attributes are associated with each instance.
Instance ID = 0 (class attributes):
Attribute ID Description Type GET SET
01 Revision: This attribute specifies the current revision of the RSTP UINT X —
Diagnostic object. The revision is increased by 1 at each new update
of the object.
02 Max Instance: This attribute specifies the maximum number of UINT X —
instances that may be created for this object on a per device basis (for
example, an RSTP bridge). There is 1 instance for each RSTP port on
a device.
X = supported
— = not supported
Instance ID = 1 to N (instance attributes):
Attribute ID Description Type GET | CLEAR | Value
01 Switch status STRUCT X — —
of
Protocol specification UINT X — Refer to RFC-4188 for attribute definitions
and value range. In addition, the following
value is defined: [4]: the protocol is IEEE
802.1D-2004 and IEEE 802.1W.
Bridge priority UDINT X — Refer to RFC-4188 for attribute definitions
and value range.
Time since topology UDINT X —
change
Topology change count UDINT X — Refer to RFC-4188 for attribute definitions
and value range.
Designated root String X — Refer to RFC-4188 for attribute definitions
and value range.
Root cost UDINT X —
Root port UDINT X —
Maximum age UINT X —
Hello time UINT X —
Hold time UDINT X —
Forward delay UINT X —
Bridge maximum age UINT X —
Bridge hello time UINT X —
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Attribute ID Description Type GET | CLEAR | Value
Bridge forward delay UINT X —
02 Port status STRUCT X X —
Port UDINT X X Refer to RFC-4188 for attribute definitions
and value range.
Priority UDINT X X
State UINT X X
Enable UINT X X
Path cost UDINT X X
Designated root String X X
Designated cost UDINT X X
Designated bridge String X X
Designated port String X X
Forward transitions UDINT X X Refer to RFC-4188 for attribute definitions
count and value range.
Services:

* Get_and_Clear: The current value of
this parameter is returned with the
response message.

» other services: The current value of
this parameter is returned without
being cleared.

03 Port mode STRUCT X — —
of

Port number UINT X — This attribute indicates the port number for
a data query. The value range is
configuration-dependent. For a 4-port
Ethernet device, as an instance, the valid
rangeis 1...4.

Admin edge port UINT X — This attribute indicates if this is a user-
configured edge port:

o 1:true

+ 2:false

Other values are not valid.
Operartor edge port UINT X — This attribute indicates if this port is an

edge port:
+  1:true
+ 2:false

Other values are not valid.
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Attribute ID Description Type GET | CLEAR | Value
Auto edge port UINT X — This attribute indicates if this port is a
dynamically determined edge port:
*  1:true
« 2:false

Other values are not valid.

X = supported
— = not supported
Services

The RSTP Diagnostics object performs these services:

Service ID Description Class | Instance Notes
hex dec
01 01 Get_Attributes_All X X This service returns:

» all attributes of the class
« all attributes of the instance of the object

02 02 Get_Attribute_Single X X This service returns:
» the contents of a single attribute of the
class
+ the contents of the instance of the object
as specified
Specify the attribute ID in the request for this
service.
32 50 Get_and_Clear — X This service returns the contents of a single

attribute of the instance of the object as
specified. Then the relevant counter-like
parameters within the specified attribute are
cleared. (Specify the attribute ID in the request
for this service.)

X = supported

— = not supported
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Service Port Control Object
Class ID
400 (hex), 1024 (decimal)
Instance IDs
The Service Port Control object presents these instance values:
* O:class
+ 1:instance
Attributes
Service Port Control object attributes are associated with each instance.
Required class attributes (instance 0):
Attribute ID Description Type Get Set
01 Revision UINT X —
02 Max Instance UINT X —
X = supported
— = not supported

Required instance attributes (instance 1):
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Attribute ID Description Type Get Set Value

hex dec

01 01 Port control UINT X X 0 (default): disabled
1: access port
2: port mirroring
3: extended port

02 02 Mirror UINT X X bit 0 (default): ETH2 port
bit 1: ETH3 port
bit 2: ETH4 port
bit 3: internal port

X = supported

— = not supported

NOTE:

+ If the SERVICE port is not configured for port mirroring, the mirror attribute is
ignored. If the value of a parameter request is outside the valid range, the service

request is ignored.

* In port mirroring mode, the SERVICE port acts like a read-only port. That is, you
cannot access devices (ping, connection to Control Expert, and so on) through the
SERVICE port.

Services

The Service Port Control object supports these services:

Service ID Name Class Instance Description

hex dec

01 01 Get_Attributes_All X X Get all attributes in a single
message.

02 02 Set_Attributes_All — X Set all attributes in a single
message.

OE 14 Get_Attribute_Single X X Get a single specified attribute.

10 16 Set_Attribute_Single — X Set a single specified attribute.

X = supported

— = not supported
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SNTP Diagnostics Object

Class ID

405 (hex), 1029 (decimal)

Instance IDs

The SNTP diagnostics list object presents the following instance values:
* O:class
+ 1:instance

Attributes

SNTP diagnostics object attributes are associated with each instance.

Instance ID = 0 (class attributes):

Attribute ID Description GET SET
01 Revision: Increased by 1 at each new update of the object X —
02 Max Instance: Maximum number of instances of the object X —

NOTE: All attributes are required in the implementation.
X = supported

— = not supported

Instance ID = 1 (instance attribute):

Attribute ID | Description Type GET SET | Value

(hex)

01 Network Time Service STRUCT X —
Configuration of:

Primary NTP server IP UDINT

address

Polling period USINT In seconds

Update CPU with USINT * 0: Do not update CPU time.
module time +  1:Update CPU time.
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Attribute ID | Description Type GET SET | Value
(hex)
Time zone UDINT Depends on the operating system of the
configuration software. Refer to reference
DTM Requirements.
Time zone offset INT In minutes
Daylight saving time USINT
bias
Daylight saving start USINT
date - month
Daylight saving start USINT MSB (4 bits): week number
date-week, day of week
LSB (4 bits):
* 0: Sunday
* 1: Monday
* 6: Saturday
Daylight saving start UDINT Seconds elapsed since midnight
time
Daylight saving end date | USINT
- month
Daylight saving end date | USINT MSB (4 bits): week number
- week, day of week
LSB (4 bits):
« 0: Sunday
« 1: Monday
* 6: Saturday
Daylight saving end time | UDINT Seconds elapsed since midnight
Reserved UDINT[15]
2 Network time service UDINT X — < 1:ldle
status »  2:Operational
3 Link to NTP server UDINT X — * 1:NTP server cannot be reached.
status * 2:NTP server can be reached.
4 Current NTP server IP UDINT X —
address
5 NTP server type UDINT X — Corresponds to the server identified in

attribute 3:
e 1:Primary

« 2: Secondary

104
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Attribute ID | Description Type GET SET | Value
(hex)
6 NTP server time quality UDINT X — Current jitter of the clock/time in

microseconds/second

7 Number of NTP UDINT X —
requests sent

8 Number of detected UDINT X —
communication detected
errors

9 Number of NTP UDINT X —
responses received
A Last detected error UINT X — « 0:NTP_NO_ERROR
*  1:NTP_ERROR_CONF_BAD_
PARAM

+  2:NTP_ERROR_CONF_BAS_CONF
«  3:NTP_ERROR_CREATE_SERVICE
«  4:NTP_ERROR_WRONG_STATE
+  5:NTP_ERROR_NO_RESPONSE

B Current date and time DATE_ X — {time_of_day UDINT, date UINT} (see CIP
AND_TIME specification)
C Daylight savings status UDINT X — « 1: Daylight savings are enabled and

the current date/time is within the
applicable period.

«  2: NTP daylight savings are not
enabled or enabled but not within the
applicable period.

D Time since last update DINT X — Amount of time elapsed since a valid
response from the NTP server (in 100 ms
increments)

-1: not updated

NOTE: All attributes are required in the implementation.
X = supported

— = not supported

Services

The SNTP diagnostics object support the following services:
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Service ID Description Class Instance | Notes

hex dec

01 01 Get_Attributes_All Re- Required | To gather all attributes into one message
quired

OE 14 Get_Attribute_Single Re- Required | To get a single specified attribute
quired

32 50 Clear_All — Required | Clears data in attributes: 6, 7, 8, 9, 10, 13

X = supported

— = not supported

Ethernet Backplane Diagnostics Object

Class ID

407 (hex), 1031(decimal)

Instance IDs

The Ethernet Backplane Diagnostics object presents the following instance values:
* O:class
* 1:instance

Attributes

Ethernet Backplane Diagnostics object attributes are associated with each instance, as
follows:

Instance ID = 0 (class attributes):

Attribute ID Needed in Implementation | Description Value Data | GET
hex Type
01 Required Revision of this object | The current value assigned UNIT | X

to this attribute is 1.

02 Conditional(") Maximum instances The largest number of UNIT | X
instances of a created
object at this class hierarchy
level.
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Attribute ID Needed in Implementation | Description Value Data | GET
hex Type
03 Conditional(™ Number of instances The number of object UNIT | X

instances at this class
hierarchy level.
(1) Required if the number of instances is greater than 1
X = supported
Instance ID = 1 (instance attributes):
Attribute ID | Needed in Description Type NV GET | Value
hex Implementation
01 Required Backplane Ethernet port status | UINT \% X Refer to Attribute 1
(link status/health of each below.
module on the backplane)
02 Required Extended health (status) of UINT \% X Refer to Attribute 2
Ethernet backplane below.
02 Conditional(") Connection Diagnostics STRUCT X
of
Maximum CIP I/O connections | UINT Number of Class 1
opened connections
opened since the
last reset
Needed in Current CIP I/O connections UINT Number of Class 1
implementation connections
currently opened.
Required Maximum CIP explicit UINT Number of Class 3
connections opened connections
opened since the
last reset.
Conditional™ Current CIP explicit UINT Number of Class 3
connections connections
currently opened.
Conditional™ CIP detected connections UINT Increments each
opening errors time a Forward
Open is not
successful
(Originator and
Target).
CIP detected connection UINT Increments when a
timeout errors connection times
out (Originator and
Target).
Needed in Maximum EIP TCP UINT Number of TCP
implementation connections opened connections (used
for EIP as client or
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Attribute ID | Needed in Description Type NV GET | Value
hex Implementation

server) opened
since the last
reset.

Required Current EIP TCP connections UINT Number of TCP
connections (used
for EIP as client or
server) currently

open.
03 Conditional™ 1/0 Messaging Diagnostics STRUCT X
of
Conditional(") 1/0 production counter UDINT Increments each
time a Class 0/1
message is sent.
1/0 consumption counter UDINT Increments each
time a Class 0/1
message is
received.
Needed in 1/0 detected production sent UINT Increments each
implementation errors counter time a Class 0/1
message is not
sent.
Required 1/0O detected consumption UINT Increments each
receive errors counter time a

consumption is
received with a
detected error.
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Attribute ID | Needed in Description Type NV GET | Value
hex Implementation
04 Conditional(") Explicit Messaging STRUCT X
Diagnostics of
Conditional(") Class 3 messages sent counter | UDINT Increments each

time a Class 3
message is sent
(client and server).

Class 3 messages received UDINT Increments each
counter time a Class 3
message is
received (client
and server).

Needed in UCMM messages sent counter | UDINT Increments each
implementation time a UCMM
message is sent
(client and server).

Required UCMM messages received UDINT Increments each
counter time a UCMM
message is
received (client
and server).

(1) Required if the number of instances is greater than 1

X = supported

Diagnostics Available through Control Expert

Introduction to Control Expert Diagnostics

Introduction

The Modicon M580 modules support online actions.

Tasks

Use online actions to perform these tasks:
+ Display EtherNet/IP objects for a remote EtherNet/IP device.

» Ping the CPU remote I/O scanner module, a remote EtherNet/IP, or a Modbus TCP
device to confirm it is active on the Ethernet network.
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» Connect to a remote device to perform these actions:
o View the remote device’s default parameter settings.
o View the remote device’s current parameter settings.
o Edit and download to the remote device its editable parameter settings.

Displaying I/O Memory Consumption

Displaying Memory Consumption

In Control Expert you can monitor the I/O memory consumption by viewing the adapter
properties. In the Project Browser, double-click Configuration > EIO Bus > Modicon
M580 remote drop. Then right-click Modicon M580 remote drop and select Properties.

This is an example of an 10-Memory tab:

Modicon M580 remote drop:1
1/0-Memory

120% 1

100% 1400 Bytes 1400 Bytes 1400 Bytes 1400 Bytes 1400 Bytes 1400 Bytes 1400 Bytes 1400 Bytes
b L

80% |
0, |
60% 1 lo70Bytes| 1366 Bytes| |1270Bytes| |1366 Bytes| [1270Bytes| [1366Bytes| [1270 Bytes| |1366 Bytes
40% |

20% 1

FAST FAST MAST MAST AUX0 AUX0 AUX1 AUX1
Input Output Input Output Input Output Input Output
= Used 34 Bytes 34 Bytes 34 Bytes 34 Bytes
Available

[ o« ][ Cancel ]

NOTE: Quantum 140CRA31200 adapter modules do not support FAST and AUXO0/
AUX1 tasks. BMECRA312+0 adpater modules do.
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Exceeding EIO Limitations

Control Expert displays a detected error in the log window if one of these events occurs:

* The size of the RIO drop memory for the MAST task exceeds 1400 input bytes or 1400
output bytes.

» The size of the RIO drop memory for the FAST task exceeds 1400 input bytes or 1400
output bytes.

* The size of the RIO drop memory for an AUX task exceeds 1400 input bytes or 1400
output bytes.

NOTE: Modicon M580 BMECRA312+0 adapter modules support FAST and AUX- tasks
(see Quantum EIO, Remote I/O Modules, Installation and Configuration Guide).
Quantum 140CRA31200 adapter modules do not.
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Firmware Update

Introduction

This chapter describes the steps for updating the firmware for your adapter module.

Firmware Update with Automation Device
Maintenance

Overview

The EcoStruxure™ Automation Device Maintenance is a standalone tool that allows and
simplifies the firmware update of devices in a plant (single or multiple).

The tool supports the following features:
+ Automatic device discovery
« Manual device identification
+ Certificate management
» Firmware update for multiple devices simultaneously

NOTE: For a description of the download procedure, refer to the EcoStruxure™
Automation Device Maintenance, User Guide.

EIO Adapter Firmware Update with Unity Loader

Overview

Use these procedures to update the firmware for the EIO adapter:

Stage Description

1 Download and install Unity Loader software.

2 Configure and store IP parameters (optional).

3 Connect your configuration PC to the EIO adapter.

4 Transfer the firmware update to the EIO adapter or the Ethernet backplane.
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The minimum required version of Unity Loader is V8.0.

These instructions apply to the BMXCRA31200, BMXCRA31210, BMECRA31210, and

140CRA31908 modules.

Downloading and Installing Unity Loader

Download the Unity Loader software to your PC:

Step Action

1 Enter the web address for Schneider Electric (www.se.com) in an Internet browser.

2 In the Search from input field, enter the phrase Unity Loader and press Enter.

3 Examine the search results and select the appropriate entry for the Unity Loader software.

4 Follow the on-screen instructions to download both the Unity Loader installation software and any
necessary installation instructions.

5 Run the Unity Loader setup file and follow the instructions (on the screen and in the downloaded
documentation) to install Unity Loader.

Default Address Configurations

If the CRA IP address is not configured, you can temporarily use its default IP address by
setting the rotary switch to Stored. This default IP address is overwritten when you configure
and store valid IP parameters.

The adapter uses these default address configurations:

Parameter

Description

Default IP Address

The default IP address starts with 10.10 and uses the last two bytes of the MAC
address. As an example, a device with the MAC address of 00:00:54:10:8A:05
has a default IP address of 10.10.138.5 (0x8A=138, 0x05=5).

NOTE: When the last two octets of the MAC address (MAC5.MAC6)
correspond to 0.0 in the default address, make a point-to-point cable
connection between your computer and the controller, communication
module, or other module.

Default Sub-Network Mask

The default mask is 255.0.0.0 (a class A mask).

Default Gateway Address

The default gateway address is identical to the default IP address.
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The default address is based on the adapter MAC address. This makes it possible for
several Schneider Electric devices to use their default network configurations on the same
network.

To configure and store IP parameters that are not the default values for the remote drop

adapter:
Step Action
1 Start or re-start the adapter with the rotary switch set toStored.
2 Store the IP address by sending a explicit message to the TCP/IP Interface Object, page 82
(Attribute ID 05: Interface Configuration).

NOTE: The adapter uses the stored IP parameters only after a power cycle.

Connect the Configuration PC to the EIO Adapter

Connect your configuration PC (that is running Unity Loader) directly to the adapter module
via an Ethernet port.

Verify that communications are established between the PC and the adapter by issuing a
ping command from the PC:

Step Action Comment

1 Open a command window on the PC. Start > Run.

2 In the Run dialog, type in cmd.

3 Click OK.

4 At the command prompt, type in the ping Example: C:\>ping 192.168.21.38:
command and the device IP address.

5 The command window verifies that a Example: Reply from192.168.21.38...
connection is established.

Update Procedure

Do not interrupt the firmware download process by:
+ allowing an interruption to the power or communications
» closing the Unity Loader software

If the firmware download process is interrupted, the new firmware is not installed and the
adapter continues to use the old firmware. If an interruption occurs, restart the process.

114 EI00000001584.13



Firmware Update RIO Modules

NOTE: If the download is not completed, there is a message saying that the update was
unsuccessful.

To update the firmware for the EIO adapter:

Step Action

1 Open Unity Loader on your PC. (Start > Programs > Schneider Electric > Unity Loader)

Result: Unity Loader opens and displays the Project tab.

2 At the bottom of the tab in the Connection area, connect to the module:
* Inthe Media list, select Ethernet.
* Inthe Address field, type in the IP address of the adapter, which is either:

o configured: The adapter is already communicating on the network and the IP address
for the module is configured in the application in the BME+58++40 CPU module.

o default: The adapter rotary switch position is Stored and you did not already store valid
IP parameters.

* Click Connect.

3 After Unity Loader has connected to the module, click the Firmware tab in the Unity Loader
dialog.

4 In the PC area, click the ellipsis (...) button to open a dialog where you can navigate to and select
the firmware file for the adapter module. The firmware is contained in a Unity Loader file (.LDX
extension).

NOTE: When using the BMECRA31210, you can also update firmware for a BMEXBP-++00.

After you select the firmware file and close the dialog, the selected revision of this firmware is
displayed in the list on the left, and the current version of the firmware is displayed in the list on
the right.

5 When the arrow in the middle of the Unity Loader dialog is green, click Transfer.

NOTE: Only click Transfer if the arrow is green. A yellow arrow indicates that the firmware
file on your computer is the same version or newer than the file selected for transfer; a red
arrow indicates that the firmware on the computer is not compatible with the EIO adapter.

6 Click Yes on the 2 dialogs that appear.

7 The Transferring data to PLC opens, which indicates the transfer status with the blue bars at the
bottom of the screen.

8 After the transfer is complete, click Close.

9 In the Unity Loader software, click Disconnect and close the window.

10 Reboot the module to finalize the firmware update.

From 1 instance of Unity Loader, you can only update 1 device. To update several devices
at the same time, open additional instances of Unity Loader. In this case, additional dialogs.
Click Yes to close each dialog.

The update process takes approximately 3 minutes:
+ firmware update (approximately 2 minutes)
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» reboot, reestablish I/O connections (1 minute)

During the firmware update, the /O communication with the adapter module is interrupted.
After the hold up time, page 56 expires, the output modules move to the pre-configured
fallback setting (a value of 0, 1, or hold last value).
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Glossary

A

adapter:

An adapter is the target of real-time 1/0 data connection requests from scanners. It cannot
send or receive real-time I/O data unless it is configured to do so by a scanner, and it does
not store or originate the data communications parameters necessary to establish the
connection. An adapter accepts explicit message requests (connected and unconnected)
from other devices.

AUX:

An (AUX) task is an optional, periodic processor task that is run through its programming
software. The AUX task is used to execute a part of the application requiring a low priority.
This task is executed only if the MAST and FAST tasks have nothing to execute. The AUX
task has two sections:

* IN: Inputs are copied to the IN section before execution of the AUX task.
» OUT: Outputs are copied to the OUT section after execution of the AUX task.

B

broadcast:

A message sent to all devices in a broadcast domain.

C
CCOTF:

(change configuration on the fly) A feature of Control Expert that allows a module hardware
change in the system configuration while the system is operating. This change does not
impact active operations.

CIP™:

(common industrial protocol) A comprehensive suite of messages and services for the
collection of manufacturing automation applications (control, safety, synchronization,
motion, configuration and information). CIP allows users to integrate these manufacturing
applications with enterprise-level Ethernet networks and the internet. CIP is the core
protocol of EtherNet/IP.

EI00000001584.13 117



RIO Modules

CPU:

(central processing unit) The CPU, also known as the processor or controller, is the brain of
an industrial manufacturing process. It automates a process as opposed to relay control
systems. CPUs are computers suited to survive the harsh conditions of an industrial
environment.

D
DDT:

(derived data type) A derived data type is a set of elements with the same type (ARRAY) or
with different types (structure).

determinism:

For a defined application and architecture, you can predict that the delay between an event
(change of value of an input) and the corresponding change of a controller output is a finite
time t, smaller than the deadline required by your process.

DRS:

(dual-ring switch) A ConneXium extended managed switch that has been configured to
operate on an Ethernet network. Predefined configuration files are provided by Schneider
Electric to downloaded to a DRS to support the special features of the main ring / sub-ring
architecture.

E
EtherNet/IP™:

A network communication protocol for industrial automation applications that combines the
standard internet transmission protocols of TCP/IP and UDP with the application layer
common industrial protocol (CIP) to support both high speed data exchange and industrial
control. EtherNet/IP employs electronic data sheets (EDS) to classify each network device
and its functionality.

Ethernet:

A 10 Mb/s, 100 Mb/s, or 1 Gb/s, CSMA/CD, frame-based LAN that can run over copper
twisted pair or fiber optic cable, or wireless. The IEEE standard 802.3 defines the rules for
configuring a wired Ethernet network; the IEEE standard 802.11 defines the rules for
configuring a wireless Ethernet network. Common forms include 10BASE-T, 100BASE-TX,
and 1000BASE-T, which can utilize category 5e copper twisted pair cables and RJ45
modular connectors.
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explicit messaging:

TCP/IP-based messaging for Modbus TCP and EtherNet/IP. It is used for point-to-point,
client/server messages that include both data, typically unscheduled information between a
client and a server, and routing information. In EtherNet/IP, explicit messaging is
considered class 3 type messaging, and can be connection-based or connectionless.

F
FAST:

A FAST task is an optional, periodic processor task that identifies high priority, multiple
scan requests, which is run through its programming software. A FAST task can schedule
selected I/O modules to have their logic solved more than once per scan. The FAST task
has two sections:

* IN: Inputs are copied to the IN section before execution of the FAST task.
+ OUT: Outputs are copied to the OUT section after execution of the FAST task.

I
implicit messaging:

UDP/IP-based class 1 connected messaging for EtherNet/IP. Implicit messaging maintains
an open connection for the scheduled transfer of control data between a producer and
consumer. Because an open connection is maintained, each message contains primarily
data, without the overhead of object information, plus a connection identifier.

IP address:

The 32-bit identifier, consisting of both a network address and a host address assigned to a
device connected to a TCP/IP network.

M
MAST:

A master (MAST) task is a deterministic processor task that is run through its programming
software. The MAST task schedules the RIO module logic to be solved in every 1/O scan.
The MAST task has two sections:

* IN: Inputs are copied to the IN section before execution of the MAST task.
» OUT: Outputs are copied to the OUT section after execution of the MAST task.
multicast:
A special form of broadcast where copies of the packet are delivered to only a specified

subset of network destinations. Implicit messaging typically uses multicast format for
communications in an EtherNet/IP network.
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P
PAC:

programmable automation controller. The PAC is the brain of an industrial manufacturing
process. It automates a process as opposed to relay control systems. PACs are computers
suited to survive the harsh conditions of an industrial environment.

port 502:

Port 502 of the TCP/IP stack is the well-known port that is reserved for Modbus TCP
communications.

port mirroring:

In this mode, data traffic that is related to the source port on a network switch is copied to
another destination port. This allows a connected management tool to monitor and analyze
the traffic.

R
RIO drop:

One of the three types of RIO modules in an Ethernet RIO network. An RIO drop is an
M580 rack of I/0 modules that are connected to an Ethernet RIO network and managed by
an Ethernet RIO adapter module. A drop can be a single rack or a main rack with an
extended rack.

RIO network:

An Ethernet-based network that contains 3 types of RIO devices: a local rack, an RIO drop,
and a ConneXium extended dual-ring switch (DRS). Distributed equipment may also
participate in an RIO network via connection to DRSs or BMENOS0300 network option
switch modules.

RSTP:

(rapid spanning tree protocol) Allows a network design to include spare (redundant) links to
provide automatic backup paths if an active link stops working, without the need for loops
or manual enabling/disabling of backup links.
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S

service port:

A dedicated Ethernet port on the M580 RIO modules. The port may support these major
functions (depending on the module type):

» port mirroring: for diagnostic use

» access: for connecting HMI/Control Expert/ConneXview to the CPU
+ extended: to extend the device network to another subnet

» disabled: disables the port, no traffic is forwarded in this mode

T
TCPI/IP:

Also known as internet protocol suite, TCP/IP is a collection of protocols used to conduct
transactions on a network. The suite takes its name from two commonly used protocols:
transmission control protocol and internet protocol. TCP/IP is a connection-oriented
protocol that is used by Modbus TCP and EtherNet/IP for explicit messaging.

TCP:

(transmission control protocol) A key protocol of the internet protocol suite that supports
connection-oriented communications, by establishing the connection necessary to transmit
an ordered sequence of data over the same communication path.

trap:
A trap is an event directed by an SNMP agent that indicates one of these events:

» Achange has occurred in the status of an agent.

* An unauthorized SNMP manager device has attempted to get data from (or change
data on) an SNMP agent.

U
UDP:

(user datagram protocol) A transport layer protocol that supports connectionless
communications. Applications running on networked nodes can use UDP to send
datagrams to one another. Unlike TCP, UDP does not include preliminary communication
to establish data paths or provide data ordering and checking. However, by avoiding the
overhead required to provide these features, UDP is faster than TCP. UDP may be the
preferred protocol for time-sensitive applications, where dropped datagrams are preferable
to delayed datagrams. UDP is the primary transport for implicit messaging in EtherNet/IP.
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